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SAFETY 

Meets the requirements of BS EN60950 (Safety Requirements of Information Technology 
Equipment). 
 
Designed to be powered from an external power source which complies with the Low Voltage 
Directive (73/23/EEC). 
 
Designed for indoor use in the temperature range 5° to 40°C, 20% to 80% RH (non-
condensing). 
 
WARNING: Do not wet the product when cleaning. 
 
WARNING: This product contains a lithium battery. Do not recharge, open, heat or 
dispose of in fire. Dispose of according to local regulations. 
 
WARNING: It is important to allow enough ventilation in any surrounding enclosure so 
that the operating temperature range is not exceeded. Any enclosure should incorporate 
a fan to assist in thermal dissipation. 
 
 
 

WARNING 
 
The use of Hard Disk Cartridges other than those supplied by Timespace Technology 
will invalidate the warranty of the X200 recorder, and will constitute a breach of the X200 
operating software copyright.
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ENVIRONMENTAL 

Temperature 
The X200 may be operated in ambient temperatures from 5°C to 40°C.  This specification 
applies in still air, with the X200 mounted horizontally and ambient temperature measured 
15cms above the centre of X200. 
 
If the X200 is to be mounted in an enclosure is important that the internal temperature inside 
the enclosure does not exceed the specification above and any new enclosure design should 
be tested.  A simple but effective test is to place a thermocouple inside the enclosure and one 
outside and measure the operating temperature difference.  This difference must be deducted 
from the X200 40°C maximum. 
 
Example 
 
Temperature outside enclosure  25°C 
Temperature inside enclosure  35°C
Difference    10°C 
 
Maximum inside enclosure  40°C (X200 max) 
Maximum outside enclosure  30°C (40°C-10°C) 
 
In the above example the 40°C max spec has been de-rated to 30°C due to the effect of the 
enclosure. 
 

Forced Ventilation Within Enclosures 
It is advisable to include a fan integral to any enclosure design.  The goal of the fan is to 
remove air heated by the X200 and replace it by air at the outside temperature.  The 
temperature difference shown in the above example of 10°C can be reduced to a few degrees 
using a small fan.  Two small fans are typically better than one due to failsafe.  Fans do need 
checking periodically and can draw in large amounts of dirt and dust, this should be removed 
periodically.  To reduce dirt ingress a fan may typically be run slower than rated by reducing the 
voltage from that specified.  This can typically be done with a single resistor in series with the 
fan.  Alternatively air filters may be used but these impede airflow and require careful system 
design. The X200 does not incorporate a fan but instead uses an internal switch-mode power 
supply to reduce power consumption (and therefore heat). 
 
Fans offer two immediate benefits: 
 
1 Changing the air inside the case makes the air temperature inside the case within a 

few degrees to that outside. 
 
2 If the airflow is channelled around the top surface of the X200 so that air is drawn 

particularly over the two sides and the top, further thermal improvement is gained and 
an X200 specification of 5°C to 45°C may be used.  (The difference between the 
surface X200 case temperature and ambient temperature is typically 5°C and this is the 
extra maximum benefit). 
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Low Temperatures 
Insulating the X200 (e.g. inside an enclosure) and leaving it powered up (but not necessarily 
recording) will allow it to be used at sub zero temperatures.  To offer the best performance in 
low and high temperature environmental conditions, an insulated case can be used with a fan, 
which is thermostatically controlled to switch on when the temperature rises above 10°C.  The 
fan speed can be increased or decreased based on a thermal feedback circuit (analogue 
thermostat). 
 

Shock and Vibration 
Due to the nature of hard disk drives it is essential that the X200 is isolated from vibration and 
shock as much as possible. 
 
Consideration should be paid to the mounting position so that the levels of shock and vibration 
that may be encountered are minimized. 
 
In situations where some exposure to shock and vibration are unavoidable it is strongly advised 
that the T406 Anti-Vibration System is used.  This system is specifically designed to isolate the 
X200 from structure borne shock and vibration.  Further details and fitting instructions can be 
found in the Anti-Vibration Kit section of this manual. 
 

EMC 
The X200 complies with the relevant EEC, Automotive ‘E’ Mark and Specification 5 
(Emergency Vehicles) EMC standards for this type of product. 
 

Conformity 
X200 EMC Conformity (CE Mark) 
Meets the European Council Directive 89/336/EEC (EMC Directive) relating to EMC Emissions 
- EN61000-6-3(2001) and EMC Immunity – EN61000-6-1(2001). 

X200 EMC Conformity (E Mark) 
Meets the Type Approval requirements of European Commission Directive 95/54/EC. 

X200 PITO Specification 5 
Has met the requirements of automotive conformance regarding use in Emergency Vehicles. 
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EC Declaration of Conformity   (CE) 
 

 
 
We Timespace Technology Ltd. 
 Blackstone Rd 

Huntingdon 
PE29 6TT 

 United Kingdom 
 
declare that the 

X200 Digital Video Recorder 
 
Meets the intent of the European Council Directive 89/336/EEC referred to as the 
Electromagnetic Compatibility (EMC) Directive.  The product conforms to the following 
standards which have been listed in the Official Journal of the European Union. 

 
EMC 
Emissions: EN61000-6-3(2001) EMC Generic Emission Standard for residential, commercial 
and light industrial.  Referring to: 
 

a) EN55022(1998) Conducted, Class B 
b) EN55022(1998) Radiated, Class A 

 
Immunity: EN61000-6-1(2001) EMC Generic Immunity Standard for residential, commercial 
and light industrial.  Referring to: 
 
 a) EN55024(1998) Information Technology Equipment – Immunity Characteristics 
 b) IEC 61000-4-6(2003) RF Field 
 c) EN60801-2(1993) Electrostatic Discharge 

d) IEC 61000-4-4 (2004) Fast Transient 
 
 
 
 
 
 
............................................................................... 
Dr ROBERT HEYLEN 
TECHNICAL  DIRECTOR 
27th July 2004 
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SYSTEM OVERVIEW 

 
 
 

X200 DIGITAL VIDEO/AUDIO RECORDING SYSTEM 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

X200 DIGITAL VIDEO / 
AUDIO RECORDER 

REMOVABLE HARD DISK 
CARTRIDGE 

X201 REVIEWER & 
PROGRAMMER 

 
 
 
The X200 is a digital video/audio surveillance recorder for use in covert, portable and mobile 
applications.  
 
Recordings are made on a removable Hard Disk Cartridge inserted in the X200. After the Hard 
Disk Cartridge has been removed, the recordings can be accessed by connecting the cartridge 
to a PC, using the USB Interface Kit, (which includes PCLink200, a proprietary reading and 
archiving software package). 
 
The use of Hard Disk Cartridges other than those supplied by Timespace Technology 
will invalidate the warranty of the X200 recorder, and will constitute a breach of the X200 
operating software copyright.
 
The X201 Reviewer is used to program the menu settings on X200, to check camera views and 
to review recordings on the installed X200 Hard Disk Cartridge.  Recording will continue during 
this reviewing process. 
 
The 24-hour clock is used for all times and settings. 
 
 
 
 
 
 
WARNING: The X200 Recorder must always be mounted so that there is a free flow of air 
around it. If it is mounted in an enclosure, it is essential that adequate ventilation is 
provided, and it is recommended that a fan is incorporated in the enclosure design. 
 
 
WARNING: If the X200 Recorder is mounted in a vehicle, or otherwise subject to 
vibration, suitable damping must be built into the mounting. 
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WARNING: Hard Disk Cartridges are sensitive to shock, vibration and humidity. 
 

Diagrammatic Explanation of Use 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RECORDING 
The X200 Digital Video Recorder is used
With a removable Hard Disk Cartridge to

Record from multiple video and audio sources.

The X201 Reviewer is used for on-site 
reviewing of video/audio recordings and 
to configure the optional menu settings  
of the X200 Digital Video Recorder. 

A Wireless Local Area Network 
(WLAN) system can be used to 
download recordings from the  
X200 in a vehicle to a PC. 
 
A GSM modem can be used in 
conjunction with the X200 and 
RemoteLink software to 
configure the X200 remotely. 

REMOTE OPERATION 

REVIEWING / CONFIGURING
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PC REVIEWING / ARCHIVING
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The removable Hard Disk Cartridge
is connected to a PC (via USB Kit) to
analyse, copy or archive video/audio

recordings and to download new
operating software.
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X200 RECORDING TIME CALCULATION 

The following table allows the calculation of recording time in hours and other parameters 
shown in bold below.  Fill out 5 of the 6 entries A to F and calculate the missing entry. 
 
Number of cameras     A_______________ 
 
Number of images/sec for each camera   B_______________ 
 
Amount of motion (%) 
 Enter 100 Full Update Recording  
 Enter 80 High Motion Cond. Refresh 
 Enter 60 Bus Market Cond. Refresh 
 Enter 40 Med Motion Cond. Refresh 
 Enter 20 Low Motion Cond. Refresh C_______________ 
 
Disk size in GBytes     D_______________ 
 
Amount of time in Hours     E_______________ 
 
Resolution (Kbytes) 
 Enter 35 V. High 
 Enter 25 High 
 Enter 15 Medium 
 Enter 10 Low    F_______________ 
 
Amount of time in hours  E = (27768 x D) / (A x B x C x F) 
 
Disk size if you know the time  D = A x B x C x E x F / 27768 
 
How much % motion   C = (27768 x D) / (A x B x E xF) 
 
Number of images on disk  (100,000,000 x D) / (C x F) 
 
If audio recording is enabled then an additional 0.12 GBytes per hour must be added to 
the total amount of disk space used. 
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COMPATIBILITY WITH X100 HARD DISK 
CARTRIDGES 

The use of Hard Disk Cartridges other than those supplied by Timespace Technology 
will invalidate the warranty of the X200 recorder, and will constitute a breach of the X200 
operating software copyright.
 
1) All Cartridges from an X100 can be used in an X200, as long as X100 Operating 
 Software V1.5.0 or later is installed. 
 
2) All Cartridges from an X200 can be used in an X100. 
 
The X200 stores its operating system and menu settings internally in non-volatile flash memory 
whilst the X100 stores its operating system and menu settings on the Hard Disk Cartridge.  
Therefore all new Hard Disk Cartridges are supplied with the latest version of the X100 
operating software already installed so that the cartridges can be used in both the X200 and 
X100 without modification.   
 
Please note that as the X100 stores its menu settings on the cartridge as well as the operating 
software, using a new cartridge in the X100 will mean that all menu settings will revert to the 
factory default settings. 
 
Older cartridges which have only previously been used with the X100 can be used with the 
X200 without modification as long as the X100 operating system stored on the cartridge is 
version 1.5 or later.  The menu settings on the X200 will not be affected by using the cartridge. 
 
If the X100 operating system stored on the Cartridge is previous to version 1.5 then version 1.5 
or later will need to be loaded onto the Cartridge before it can be used with the X200. 
 
It is possible to record both .oba* (X100 file) and .xba (X200 file) on the same cartridge without 
any compatibility problems.  Please note however that the X100 will only list and play back .oba 
files and the X200 will only list and play back .xba files. 
 
Where loop recording is selected, the X200 records over oldest files first, whether they are .oba 
or .xba files.  The X100 on the other hand will overwrite files in an indeterminate manner 
(based on their physical location on disk).  Consequently if disks are to be moved from an X200 
system into an X100 system please ensure that all critical files have been archived onto a PC 
or write protected on disk. 
 
Resetting the cartridge on the X200 and thus deleting all of the recording files on the disk (all 
.oba and .xba files will be deleted) will not affect the X100 operating software. 
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X200 DIGITAL RECORDER 
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Installation 
The X200 can be used freestanding or it can be mounted on a wall or bulkhead.  
 
Power can be applied to X200 either via 12V DC jack socket (use PSU supplied with X200), or 
12V screw terminals. NB: Do not use both power inputs simultaneously. 
 
The Hard Disk Cartridge (supplied separately) with lock on the front in "Off" position should be 
inserted into receptacle in front panel of X200 and gently but firmly pushed into place, then lock 
switched to "On" position. 

Mechanical Data 
4 x threaded holes are available in the back panel of the X200 for mounting: 
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Anti-Vibration Kit 
For use in mobile installations subject to shock and vibration.  Please adhere to the following 
instructions for the installation of the Anti-Vibration Kit.  Failure to do so may result in the 
Mounting System not working correctly. 
 
Inventory of Parts 
The Anti-Vibration Kit consists of the following parts - 
 
QTY  Description 
 
4  Wire Rope Mounts 
1  Stabiliser Coupling 
8  Zinc Plated M4 x 10mm Counter-Sunk Hex-Head Screws. 
 
In addition you will require a standard ‘L’ shaped hex key.  This is essential, as when all of the 
other screws have been tightened, there is no room for any other tool to tighten the front lower 
pair of screws.   
 
Mounting Hole Preparation  
Drill four mounting holes to attach the Wire Rope Mounts.  If you intend to use the M4 x 10mm 
screws into blind holes, then the holes will have to be drilled and tapped to accept an M4 
screw, with a thread depth of no less than 8mm. 
 
If mounting the Wire Rope Mounts through a metal plate, then longer screws may have to be 
used in order to allow a washer and nut to be attached on the other side of the plate.  The 
length of these screws will have to be chosen depending on the thickness of the plate and the 
height of the washer and nut. 
 
Please note that any screw used for mounting the wire rope mounts to an enclosure surface 
must have an M4 thread and have a counter-sunk hex-head. 
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Mounting Hole Location 
The mounting holes must be drilled on 126mm and 88mm centres. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Total Mounting Volume Required 
It is necessary to allow a minimum clearance of at least 10mm around the body of the X200 
when mounted on the T406 Anti Vibration Kit.  This is to allow free movement of the X200 on 
the anti vibration mounts and to prevent collision with either the enclosure or peripheral 
systems due to vertical and lateral movement under extreme shock and vibration conditions. 
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Cable Installation 
Please note that when installing cables to the rear of the X200 it is important not to 
arrange or clamp them in such a way as to impede the free movement of the rear anti-
vibration mounts.   
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nstallation Procedure 
t is advised that some form of thread-lock compound should be used on the screws 
ecuring the wire rope mounts to both the X200 and mounting surface.  This is in order 
o prevent loosening due to vibration. 

1) Attach the Wire Rope Mounts to the X200 with four of the countersunk M4 hex-
head screws provided and L-shaped hex key.  When attaching the rear pair of 
mounts please ensure that the stabilizer is ‘sandwiched’ between the mounts and 
the X200 by aligning the stabilizer holes with the mounting holes in the X200. 

lease note that the ‘open’ end of the C-shaped plastic stabiliser should be attached to 
he rear wire rope mounts and face backward. 

 
2) Once all of the Wire Rope Mounts have been securely attached to the X200, use a 

pair of countersunk M4 hex-head screws to attach the bottom ‘feet’ of the front 
Wire Rope Mounts to the mounting surface/enclosure. 

3) Secure the lower ‘feet’ of the rear Wire Rope Mounts to the mounting 
surface/enclosure using the remaining pair of countersunk M4 hex-head screws 
and a standard L-shaped hex key.  Ensure that the stabilizer is ‘sandwiched’ 
between the lower feet and the mounting surface/enclosure by screwing through 
the Wire Rope Mount feet, then the stabilizer and into the mounting 
surface/enclosure. In
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Orientation of Unit 
The X200 should be mounted in the following horizontal orientation.  This is strongly 
advised for maximum vibration and shock isolation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If it is not po
orientation m
 
It must be n
X200 from v
 
The position
mounting ori
 
The X200 m
using this mo
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

ssible to mount the X200 in the horizontal orientation then the following vertical 
ay be used.   

oted however that this vertical orientation is not as effective at isolating the 
ibration and shock as the horizontal orientation. 

 of the plastic stabiliser, screw types and assembly order remain the same for this 
entation. 

ust never be mounted by hanging it upside down from a horizontal surface when 
unting system. 
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Connector Specifications and Diagrams 
X200-16 Rear Panel 
 

 
 

 
 
Pin numbering of both 25 Way Male D type connectors on X200 (looking at rear panel). 
 
Video 5 - 16 Connector  
 
Pin      Pin 
1 Video GND In 5    14 Video In 5  
2 Video GND In 6    15 Video In 6 
3 Video GND In 7    16 Video In 7 
4 Video GND In 8    17 Video In 8 
5 Video GND In 9    18 Video In 9 
6 Video GND In 10   19 Video In 10 
7 Video GND In 11   20 Video In 11 
8 Video GND In 12   21 Video In 12 
9 Video GND In 13   22 Video In 13 
10 Video GND In 14   23 Video In 14 
11 Video GND In 15   24 Video In 15 
12 Video GND In 16   25 Video In 16 
13 Not Connected 
 
Video 1 - 4, Out, Switcher, Audio Connector  
 
Pin      Pin 
1 Video GND In 1    14 Video In 1  
2 Video GND In 2    15 Video In 2 
3 Video GND In 3    16 Video In 3 
4 Video GND In 4    17 Video In 4 
5 Video GND Main Out   18 Video Main Out 
6 Video GND Switcher Out  19 Video Switcher Out 
7 Audio GND Out 2 (right)   20 Audio Out 2 (right) 
8 Audio GND Out 1 (left)   21 Audio Out 1 (left) 
9 Audio GND In 1 (left)   22 Audio In 1 (left) 
10 Audio GND In 2 (right)   23 Audio In 2 (right) 
11 Video GND Main Out S-Video Y  24 Video Main Out S-Video Y 
12 Video GND Main Out S-Video C  25 Video Main Out S-Video C 
13 Not Connected 
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X200-16 Cable Harness Recommended Specification 
A common cable harness can be used for both 25 Way D type connections on the X200-16 
 
Connector 25 Way Female D type 
Shell Recommended max overall width 56mm (the two 25 way connectors are 

57mm apart) 
Cables  12 individual RG179 cables of suitable length. 

 
Connections   Shield pin Core Pin 

Cable 1  1  14 
Cable 2  2  15 
Cable 3  3  16 
…………….. 
Cable 12 12  25 
 
Pin 13 not connected. 
 

X200-04 and X200-16 Input/Output Connector 
 

 
 
 
Connect power input to either + - terminals or to 2.1mm jack socket 
Connect alarm inputs 1, 2, 3 and 4 to - terminal if closed, leave open circuit if open 
Connect alarm output to Out terminal pair 
Connect LED 1 between + and terminal LED 1, including a series resistor to limit current. 
Connect LED 2 between + and terminal LED 2, including a series resistor to limit current. 
Terminals LED 1 and LED 2 are high impedance (LAMP/LED off) or 0V (LAMP/LED on) 
 
LED outputs 1 and 2 can be menu assigned to duplicate any of the 4 front panel LEDs (power, 
record, service and fail).  Please refer to the Troubleshooting section of this manual for the 
operation of the Service and fail LED’s. 

X200-04 and X200-16 Ethernet Connector 
 

 
 
Connect via a normal Ethernet cable (straight i.e. pins 1-1, 2-2, 3-3 etc.) to Ethernet hub, 
switch, router or wireless LAN adaptor. 
 
Internal Connections: 1 Tx+, 2Tx-, 3 Rx+, 4 NC, 5 NC, 6 Rx-, 7 NC, 8 NC 
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X200-04 and X200-16 RS232 Connector 
 

 
 
The X200 has a 9 way male D-type connector (DB9) which can be used to support 1 or 2 
RS232 peripherals. 
 

Conventional Cable 
 
Using a conventional cable (DB9 male to DB9 female straight through (1-1, 2-2, 3-3 etc.)) the 
X200 can be connected to a modem: 
 
Pins on the X200 
      X200 output 
Pin      X200 input  
     
3 TD Transmit Data   Serial Data (0 = 10V, 1 = -10V) 
2 RD Receive Data   Serial Data (0 = 10V, 1 = -10V) 
 
7 RTS Request to send  Handshaking (please send signal = 10V) 
8 CTS Clear to send   Handshaking (please send signal = 10V ) 
 
4 DTR Data terminal ready  X200 outputs 5V (data terminal is ready) 
6 DSR Data set ready   Ignored by X200 
1 DCD Data carrier detect  Used to detect that modem is on air (=10V) 
9 RI Ring Indicator   Ignored by X200 
5 GND Ground 
 

Proprietary Dual RS232 Device Cable 
 
This supports the connection of two RS232 peripherals such as GSM modem and GPS (Global 
Positioning System). 
 
RS232 port 1 (Modem) 
      X200 output 
Pin      X200 input  
     
3 TD Transmit Data   Serial Data 
2 RD Receive Data   Serial Data 
 
7 RTS Request to send  Handshaking 
8 CTS Clear to send   Handshaking 
 
1 DCD Data carrier detect  Used to detect that modem is on air (10V) 
5 GND Ground 
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RS232 port 2 (other device) 
 
4 5V Power supply for GPS unit (500mA max) 
6 Ignored by X200    
9 RD Receive Data   Serial Data 
5 GND Ground 
 

X200-04 Rear Panel 
 

 
 
 
1 BNC video output 
4 BNC video inputs 
 

Audio Connector 
5 pin 180° female DIN connector (DIN 41524) 
 
 

 
Pin  
1 Audio input 1 (left) 
4 Audio input 2 (right) 
2 Audio GND 
5 Audio output 2 (right) 
3 Audio output 1 (left) 
 
The audio signals are at line level 
 
A 5 pin DIN to 4 way RCA phono harness can be readily purchased from a number of 
suppliers.  Suggested search via www.google.com for “5 pin din to rca phono audio”. 
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X200 Front Panel 
 
 

 
 
 

Record Button  
Turns Normal recording on and off.  Can be menu disabled. 

LED Indicators 
Record LED 
Illuminated when the X200 unit is recording. 
 
Service LED  
Not currently used. 
 
Fail LED 
Illuminated when the X200 video recorder is unable to make recordings.  Check that the hard 
drive cartridge is properly inserted and locked in. 
 
Power LED 
Illuminated constantly while power is supplied to the X200. 
 
At Power On 
All four LED’s will illuminate whilst the X200 initialises and will remain lit during system check 
(menu disabled) until the unit is operational.  Once operational only the Power LED will remain 
illuminated unless recording is taking place. 
 
At System Reboot 
If the Hard Disk Cartridge is switched off and then on (or replaced) or the Load System 
Upgrade has been performed the X200 will reboot.  In this case as per at power on all four 
LED’s will illuminate whilst the X200 initialises and will remain lit during system check (menu 
disabled) until the unit is operational.  Once operational only the Power LED will remain 
illuminated unless recording is taking place. 
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Reviewer Connector 
 

 
 
Connect X101 or X201 reviewer to X200 using this socket.  Signals for this connector are as 
follows: 
 
1  Video out 
2 Video ground 
3 Audio ground 
4 RS232 Rx 
5 RS232 Tx 
6 Audio out (line level) 
7 Power ground 
8 12V 
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Programming 
The configuration of the X200 is by the menu system, this is accessed using the X201 
Reviewer.  Please refer to the section on the X201 Reviewer for details of its use. 
 
Connect Data Link Cable (supplied with X201 Reviewer) from socket marked "Reviewer" on 
X200 to socket marked “Recorder” on X201. This connection will provide power and video to 
X201 from X200. 
 
To enter Menu System press any of the four MENU arrow buttons.  To exit the Menu System or 
to move back up a level press the MENU EXIT button. 

 

Help Screens 
Throughout the menu system, every item that the cursor points to has a Help screen. Place the 
cursor on the line requiring explanation and press the HELP key on the X201 front panel. Use 
any key to cycle through the screens for that line.  
 
Help screens are available for each menu heading and for all items contained within the menu. 
 
The help system is very comprehensive and it is strongly recommended as a reference to both 
new and experienced users. 
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Software Updates 
Occasionally software improvements are made to X200 and a new version of software is made 
available.  The software takes the form of a .xos file.  Follow these steps to install new 
software:  
 
Go to OTHER MENU > ADVANCED MENU in the X200 menu system. 
 
• LOAD SYSTEM UPGRADE – This loads a new version of the X200 operating system from 

the Hard Disk Cartridge.  Do the following. 
 

Delete all recordings on the Hard Disk Cartridge using the reset menu. 
Using the USB interface kit copy the new .xos file from the PC to the Hard Disk Cartridge. 
Right click the .xos file on the Hard Disk Cartridge and select properties. 
Left click to tick the ‘Read-only’ box at the bottom of the properties window and click OK. 
Insert the Hard Disk Cartridge into the X200 and stop it recording if it is currently doing so. 
Run LOAD SYSTEM UPGRADE by pressing the right menu button. 
 
Check the software version in the statistics menu to verify the new version has been loaded. 

 
• SAVE SYSTEM UPGRADE – This saves the X200 operating system and current menu 

settings to the Hard Disk Cartridge as a .xos file. 
 

The Cartridge can then be used as a master to set up another X200 with the same software  
version and menu settings.  Use LOAD SYSTEM UPGRADE on the other X200 with the  
master Cartridge inserted. 
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PAL/NTSC Switching 
Introduction 
From software version 1.2.0, the X200 offers the ability to switch between the different video 
standards; PAL and NTSC. 
 
• PAL (Phase Alternating Line) is the standard used in most European countries with the 

exception of France.  The X200, when configured to use PAL, offers a maximum capture 
rate of 25 fields per second. 

 
• NTSC (National Television Standards Committee) is the standard used in the United States 

of America. The X200, when configured to use NTSC, offers a maximum capture rate of 30 
fields per second. 

 
When configured to use one of these standards, the X200 must use it exclusively.  This means 
that cameras of different types cannot be mixed on the device’s inputs.   
 
Note that if the unit is configured for PAL and an attempt is made to play back NTSC 
recordings, the image will appear vertically ‘squashed’.  Similarly, if the unit is configured for 
NTSC and an attempt is made to playback PAL recordings, the image will be clipped. 

Switching Video Standards 
To switch between the required video standard, the user must configure the unit using the 
ADVANCED menu.  This is shown below: 
             
 

|     ADVANCED     | 
>USE RECORD STATE AT POWER OFF 
 ENABLE X200 RECORD BUTTON: YES 
 
 LOAD SYSTEM UPGRADE.. 
 SAVE SYSTEM UPGRADE..  
 
 RECORDING MODE FOR: 
   NORM / TIMER:  COND. REFRESH 
   ALARM / SHOT:  FULL UPDATE 
 VIDEO STANDARD:  PAL 
 MODEM LOOPBACK TEST 
H/W VER:16AE   SERIAL NO:83747 

 
 
After moving the cursor down the Video Standard line, the user can use the cursor keys to 
select between PAL and NTSC.  Once the appropriate selection has been made the unit must 
be power-cycled before it comes into effect.  During the power up sequence, the X200 will 
briefly display the software version installed along with the configured video standard. 
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File System 
The X200 uses a proprietary file type with the file extension .xba 
 
Images from multiple cameras along with audio, GPS and other data are stored in these files.  
The images are compressed using MPEG2 data compression in either non-predictive (full 
update) mode or predictive (conditional refresh) mode.  For security and optimisation reasons 
.xba files can only be viewed on a PC using the proprietary PCLink200 software. 
 
For most applications there are two types of normal recording available, loop and single pass. 

Loop Recording 
By selecting LOOP RECORD from the RECORDING MODE option in the file system menu. 
 
 
 

        FILE      SYSTEM      
     
 RECORDING MODE : >LOOP RECORD 
  
 
 
   
This will set the X200 to automatically delete oldest recordings first when the Hard Disk 
Cartridge is full (with the exception of write-protected files).  The record position is stored and 
any playback will not affect the current record position (this is in contrast to a VHS tape). 
 
Write-protection can be used to keep Alarm recordings but loop the background (Normal) 
recording.  
 

Single Pass Recording 
By selecting SINGLE PASS from the RECORDING MODE option in the file system menu. 
 
 
 

        FILE      SYSTEM      
     
 RECORDING MODE : >SINGLE PASS 
  
 
 
    
The X200 records until the Hard Disk Cartridge is full and then stops.  Recordings may be 
deleted in the RESET menu or loop recording enabled so that the oldest files will be overwritten 
first.  
 
 

28 

In
te

llig
en

t S
ec

ur
ity

 &
 F

ire



Transferring Images to Video Tape 
It is possible to transfer recorded footage from an X200 to a video recorder. 
 

Connections 
X200-04 
The X200 composite video out BNC connector marked ‘Video Out’ on the rear panel of the 
X200-04 is connected to the video recorders BNC composite video input using a BNC-BNC 
lead.  If the video recorder does not have a BNC connector for video input then it is possible to 
use a suitable adaptor (for example BNC to RCA) as long as the video recorder input is of a 
composite video type. 
 
X200-16 
The ‘Video Main Out’ and ‘Video GND Main Out’ on the 25 way male D-type connector on the 
rear panel of the X200-16 are connected to the signal and GND connections of the composite 
video input of the video recorder with an appropriate lead. 
 

Recording 
Connect the X200 video out to the video recorders video input using a suitable lead.  Insert a 
suitable tape into the video recorder and rewind / fast forward until it is in the desired recording 
position. 
 
Using an X201 reviewer select the file to be transferred from the X200 by using the files menu.  
Scroll through the file list until the required file is found and then press the right menu button 
next to the file so that it appears on the screen of the X201 Reviewer.   
 
Once selected, the footage will automatically begin to play, press the stop button immediately 
to avoid missing the first part of the footage.  The footage may be rewound if necessary using 
the rewind control on the X201 (please refer to the chapter on the X201 Reviewer for specific 
details on playback controls).  If a different camera view is required then this can be selected by 
pressing the appropriate number key on the X201 Reviewer relating to the camera input 
number on the X200. 
 
When ready press record on the video recorder and then press play on the X201 Reviewer to 
restart the footage from the X200.  The selected camera view from the file should now be seen 
playing on the X201. 
 
When the file has been recorded press stop on the video recorder and on the X201 reviewer. 
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Video Compression 
The X200 records images, audio, GPS and other data into 10 minute or 1 hour proprietary 
format files ending with the .xba file extension.  A trade-off between image quality and file size 
can be made by selecting from the four levels of video quality: low, medium, high and v. high.  
The low setting uses greater compression than the high settings and consequently less disk 
space is used. 
 
As image quality rises however so does the resultant file size so a decision will have to be 
made as to the level of image quality needed and the length of recording required to be stored 
on any given size of Hard Disk Cartridge. 

Non-predictive compression (full update) 
In the Advanced Menu the user can select between two compression styles.  The first, “Full 
Update Recording” means that a full image is stored every time.  Each image stands alone in 
its own right and uses no prediction from previous images – the recording type is termed non-
predictive.  The advantage of full update recording is that each image is independent and free 
from any inter-image distortion.  The images can also be searched easily during playback.  The 
disadvantage is that no use is made of any similarity between successive images and the 
compression performance can be up to 5 times worse (but typically 3 times worse) than 
conditional refresh recording. 

Predictive Compression (conditional refresh) 
With conditional refresh recording the X200 stores a full image followed by a sequence of 
partial images for each camera.  When the file is searched, the full image (known as the 
keyframe) is used as a starting point for playback.  The X200 uses a powerful algorithm that 
detects motion and for each partial image, only updates areas of the image that require it.  
Partial images may be 1/10th the size of the full images when there is little motion in a scene.  
There is no cumulative error (which can occur in some MPEG implementations) and the 
difference between full update recording and conditional refresh recording is designed to be 
imperceptible.  The advantage of conditional refresh recording over full update recording is the 
compression performance is superior (typically 3 times). 
 
The system defaults to using conditional refresh for normal and timer recording and full update 
for shot and alarm recording. 
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Audio 
The X200 has two line-level audio input and output channels.  Connection to the X200 is via a 
5 pin 180° female DIN connector (DIN 41524) on the rear panel of the X200 which is detailed in 
the Connector Specifications section of this manual. 
 
The two input channels can be assigned to all cameras or a single camera in order to associate 
recorded sound with the appropriate cameras and images for a particular installation. 
 
The audio channels can be played back individually or together when viewing footage in 
PCLink200 PC software.  They can also be disabled during playback. 
 
The X201 Reviewer can also be used for audio playback through its built in speaker.  The 
audio signal is carried to the reviewer via the RJ45 reviewer cable, no other connections are 
necessary.   It must be noted that at present playback via the X201 is in mono via channel 1 
only.   
 
The audio inputs on the X200 Recorder are line-level.  Therefore some microphones will 
require the use of a dedicated preamplifier in order to raise their very low levels of output to 
line-level.  The X200 is configurable so that the line-level input range can be set from 0.12 – 
2.0Vrms. 
 
For detailed information on configuring the audio settings in the X200 please refer to the Audio 
Recording Menu in the Menu System section of this manual. 
 
 
 
 

2 Channel audio recording with 2 microphones and a pre-amplifier. 
 
 
 
 
 
 
 
 
 

Microphone 

X200 
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PC Access Precautions 
It is important to understand that the X200 file system is a subset of the PC FAT32 file system.  
The PC will access the X200 disk cartridges with no problems but the X200 will not be able to 
read every FAT32 file system written by the PC. 
 
Permitted on a PC 
Reading the .xba files 
Modifying the write-protect status of files 
Performing disk utilities that read the disk (e.g. Scandisk) but do not modify disk 
 
Not Permitted on a PC 
All write accesses to the disk if it is to be reused in an X200.  These include: 
  
Formatting the disk on PC 
Defragmenting the disk 
Deleting files 
Renaming files 
Generating new files 
Creating a recycle bin on the disk 
 

Watermark 
The X200 uses a fragile watermark.  Any modification to the image data e.g. changing faces, 
lighting, contrast or other modifications will destroy the watermark.  The image data that makes 
up the image set is passed though a function that generates a "magic number" or hash code 
from the images.  The terms hash code and watermark are synonymous.  A hash code is 
created automatically by the X200 for each image set and is then highly encrypted and stored 
in the information block.   
 
The hash code can be de-encrypted and regenerated by passing the image data back though 
the function (i.e. in a watermark checking program).  If the hash code thus obtained matches 
the hash code stored in the information block, the image data has not been altered or modified 
in any way.  The watermark is "destroyed" when the hash code stored in the information block 
and the hash code of the data do not match. 
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GPS 
The Global Positioning System (GPS) is a worldwide radio-navigation system formed from a 
constellation of 24 satellites (placed in orbit by the US Department of Defence; the first was 
launched in 1978) and their ground stations.  Using accurate timing information, a GPS 
receiver (GPSr) is able to calculate its position using triangulation. 
Anyone with a GPSr can use the system to determine their position anywhere in the world with 
an accuracy of around 15 metres. 
 
The accuracy is determined by the quality of the satellite signals and the number of them ‘in 
sight’.  The GPSr must be positioned so its antennae have a clear line of sight of the sky – 
obstructions such as foliage and reflected signals in built-up areas can reduce the accuracy. 

NMEA-0183 Interface Standard 
The National Marine Electronics Association (NMEA) develops and maintains a number of 
standards related to the marine electronics industry. 
The NMEA-0183 Interface Standard defines electrical signal requirements, data transmission 
protocol and time, and specific sentence formats for a 4800-baud serial data bus. Each bus 
may have only one talker but many listeners.  The X200 Digital Video Recorder supports GPS 
receivers that are NMEA-0183 compliant. 

GPS Mice 
A number of GPS receivers on the market are commonly referred to as GPS Mice because 
they consist of a GPS engine (GPS receiver and embedded antenna) in a compact case with a 
single power/data cable.  Once powered up these devices send out the GPS data over the 
serial data connection using the NMEA-0183 protocol standard. 
Since the X200 Digital Video Recorder provides +5V power out to the GPS mouse, only those 
which operate at this voltage and draw no more than 200mA should be used.   The X200 
Digital Video Recorder has been tested with the following GPS receivers: 

• Garmin GPS16 LVS 

• RoyalTek Sapphire Serial GPSr 

• Fortuna U2 Smart GPS 
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Configuration 

Connection 
The GPS receiver is connected to the X200 Digital Video Recorder through the RS232 port.  
The diagram below shows the 9 way D-type connector viewed from the back of the X200 and 
details those pins to be used for the serial data connection and the +5V supply to the GPS 
receiver. 
 
Note that the +5V supply is only intended to provide power to a GPS receiver with a 
current consumption of no more than 200mA. 
 
 

 
 
 

GPS Receiver Connections 
Pin Connection 
4 +5V supply 
5 0V 
9 Data 
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X200 GPS Options 
Configuration of the X200’s GPS options is done via the menu system accessed using a X201 
reviewer.  The GPS menu option presents the user with a number of options allowing the 
embedding of GPS position and speed and the units to be used. 
 
If no valid GPS signal is being received then the X200’s GPS menu page is similar to that 
shown below: 
 

            |  GPS  |      
                   
 
   RECORD GPS DATA:       YES 
   EMBED GPS POSITION:   >YES 
   EMBED GPS SPEED:       YES 
   SPEED UNITS:           MPH 
 
   SYNC CLOCK WITH GPS:   YES 
   LOCAL STANDARD TIME:   UTC 
             
   NO GPS SIGNAL   
    
 

 
Or, if valid GPS data is being received, it is displayed towards the bottom of the screen: 
 

            |  GPS  |      
                   
 
   RECORD GPS DATA:       YES 
   EMBED GPS POSITION:   >YES 
   EMBED GPS SPEED:       YES 
   SPEED UNITS:           MPH 
 
   SYNC CLOCK WITH GPS:   YES 
   LOCAL STANDARD TIME:   UTC 
 
   00011.8464W      5220.5986N 
    18 MPH 
 

 

Record GPS Data 
This option determines whether the serial data from the GPS receiver will be recorded by the 
X200 Digital Video Recorder.  Note that if no GPS data is received by the X200 (because no 
functional GPS receiver is connected) then there will be no data recorded either. 
 
If a GPS receiver is connected but satellite lock has been lost then it is still possible to record 
the data but it will not indicate position, speed, date or time and the actual content may vary 
according to the type of GPS receiver employed. 

Embed GPS Position 
Selecting YES to ‘EMBED GPS POSITION’ will cause the position information to be embedded 
in the recorded image. 
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Embed GPS Speed 
Selecting YES to ‘EMBED GPS SPEED’ will cause the speed information to be embedded in 
the recorded image. 
 
Note that speed and position information will only be embedded in the video image when the 
GPS signal is valid and the position can be calculated. 

Speed Units 
Select either KPH for kilometres per hour or MPH for miles per hour. 

Sync Clock with GPS 
The X200 Digital Video Recorder includes a clock which is used to timestamp recording files 
and overlay the date and time on recorded images.  Although accurate, the system can be 
configured to synchronize the clock with the date and time information received from the GPS 
receiver.  
 
Synchronization only occurs when the X200 is powered up and before it starts recording.  At 
this time the built-in clock may be corrected by a maximum of 20 seconds if a previous 
discrepancy has been detected between the internal time and the GPS receiver time. 

Local Standard Time 
The time received from the GPS receiver is always UTC (Coordinated Universal Time) which is 
the same as GMT (Greenwich Mean Time).  In order to correctly work out the error between the 
local standard time (used by the X200’s internal clock) and that received from the GPS 
receiver, the system must be set with the correct time zone offset. 
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Troubleshooting 

Satellite Signal Quality 
In order to calculate its position, a GPS receiver must be receiving signals from at least 3 
satellites and do to so it must have a clear view of the part of the sky in which they are located.  
GPS receivers do not work indoors. 
 
When first powered up the GPS receiver will search for satellite signals.  The signal includes 
information on the position of other satellites and all this information must be received before 
an accurate position calculation can be made.  It can take a minute or two before a valid 
position can be determined after the GPS has been powered up. 
Even when a signal is being received from a sufficient number of satellites, a number of factors 
can result in the degradation of the accuracy of the calculated position.  These include: 

• Atmospheric Delays.  The satellite signal slows as it passes through the ionosphere 
and troposphere.  A model built in to the GPS calculations compensates by an average 
delay to partially correct this error. 

• Signal Multipath.  This occurs when the satellite signal is reflected before reaching the 
receiver.  The delays caused by the additional travel time can cause errors. 

• Receiver Clock Errors.  The GPS receiver’s built-in clock is not as accurate as the 
atomic clock on the satellites and so slight timing errors can result. 

• Orbital Errors. Cause by inaccuracies of the satellites’ reported position. 

• Satellite Visibility.  The greater the number of satellites that the GPS receiver is able 
to receive a signal from, the better the accuracy of the calculated position.  Buildings, 
terrain or electrical interference can block the signals. 

• Satellite Geometry. The GPS satellites are constantly moving, orbiting the earth at a 
height of around 11,000 miles.  Each making at least two complete orbits in any 24 
hour period. Ideal satellite geometry occurs when the satellites are located at wide 
angles relative to each other – poor geometry, when the satellites are close together or 
in a line, results in poorer accuracy. 

GPS Receiver 
A simple test to ensure that a ‘GPS mouse’ is functioning is to connect it to a PC’s serial port 
and use an application such as Microsoft® HyperTerminal® which comes as part of the 
Microsoft® Windows® operating system. 
HyperTerminal® is a terminal emulator application that can be used to connect to other devices 
using an RS232 serial port.  Other similar applications are available but in each case the serial 
port to which the GPS receiver is to be connected should be configured to use the following 
settings: 
 

Baud Rate (bits per second) 4800 
Data Bits 8 
Parity None 
Stop Bits 1 
Flow Control None 
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The following display shows HyperTerminal® being configured with the GPS mouse connected 
to COM1: 
 

 
 
Even if the GPS receiver is receiving no satellite data (for example, if it is being tested inside) 
then when it is connected to the serial port and a suitable power supply, it should start sending 
NMEA-0183 sentences similar to those shown below: 
 

 
$GPGSA,A,1,,,,,,,,,,,,,50.0,50.0,50.0*05 
$GPRMC,021341.581,V,36000.0000,N,72000.0000,E,,,270102,,*2B 
$GPGGA,021342.581,36000.0000,N,72000.0000,E,0,00,50.0,0.0,M,,M,,0000*4C 
$GPGSA,A,1,,,,,,,,,,,,,50.0,50.0,50.0*05 
$GPRMC,021342.581,V,36000.0000,N,72000.0000,E,,,270102,,*28 
$GPGGA,021343.581,36000.0000,N,72000.0000,E,0,00,50.0,0.0,M,,M,,0000*4D 
$GPGSA,A,1,,,,,,,,,,,,,50.0,50.0,50.0*05 
$GPRMC,021343.581,V,36000.0000,N,72000.0000,E,,,270102,,*29 
$GPGGA,021344.581,36000.0000,N,72000.0000,E,0,00,50.0,0.0,M,,M,,0000*4A 
$GPGSA,A,1,,,,,,,,,,,,,50.0,50.0,50.0*05 
 

 
The above sentences were recorded when no satellite signals were being received.  The first 
‘0’ after the ‘E’ character in the GPGGA sentence indicates invalid fix and the first ‘V’ character 
in the GPRMC sentence indicates navigation warning. 
 
If no serial data is received then the GPS receiver is not functioning correctly and so the first 
course of action should be to either investigate the problem or replace it. 
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Embedded Information 
If the option to embed the GPS data within the video image is selected then the information is 
seen above the data and time information.  The example below shows both position and speed 
information embedded within the image: 
 

 
 
The top line of the embedded information shows the position as longitude followed by latitude 
in the following format: 
 

DDDMM.MMMMH   ddmm.mmmmh 
 

where the fields are: 
 
DDD The longitude degrees. 
MM.MMMM The longitude minutes (as a decimal) 
H The longitude hemisphere (‘W’ for west of the meridian, ‘E’ for east of the 

meridian) 
dd The latitude degrees 
mm.mmmm The latitude minutes (as a decimal) 
h The latitude hemisphere (‘N’ for north of the equator, ‘S’ for south of the 

equator) 
 
In the above example, the current coordinates are 0° 11.8464’W, 52° 20.5986’N.  Expressed as 
degrees, minutes, seconds this is 0° 11’ 50.784”W, 52° 20’ 35.916”N 
 
The line below the position shows the camera name (blank in the above example) followed by 
the speed displayed in the selected units.  The third and final line shows the camera number, 
the time and the date. 
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NMEA Sentences 
The NMEA-0183 interface standard defines electrical signal requirements, data transmission 
protocol and time, and specific sentence formats for a 4800 baud serial data bus.  Those 
sentences that are relevant to GPS data and recorded by the X200 Digital Video Recorder are 
detailed below: 

GPGGA - Global Positioning System Fix Data 
This sentence includes the positioning fix information with additional information about the 
accuracy of the fix and the satellites used in its determination. 
 
$GPGGA,123519,4807.038,N,01131.324,E,1,08,0.9,545.4,M,46.9,M, , *42 
 
           123519        Fix taken at 12:35:19 UTC 
           4807.038,N    Latitude 48 deg 07.038' N 
           01131.324,E   Longitude 11 deg 31.324' E 
           1             Fix quality: 0 = invalid 
                                      1 = GPS fix 
                                      2 = DGPS fix 
           08            Number of satellites being tracked 
           0.9           Horizontal dilution of position 
           545.4,M       Altitude, Metres, above mean sea level 
           46.9,M        Height of geoid (mean sea level) above WGS84 
                         ellipsoid 
           (empty field) time in seconds since last DGPS update 
           (empty field) DGPS station ID number 
           *42           Mandatory checksum 

GPGSA - GPS DOP and active satellites 
This sentence  
 
$GPGSA,A,3,04,05,,09,12,,,24,,,,,2.5,1.3,2.1*39 
 
           A             Auto selection of 2D or 3D fix (M = manual) 
           3             3D fix 
           04,05...      PRNs of satellites used for fix (space for 12) 
           2.5           PDOP (dilution of precision) 
           1.3           Horizontal dilution of precision (HDOP) 
           2.1           Vertical dilution of precision (VDOP) 
             (DOP is an indication of the effect of satellite geometry on 
             the accuracy of the fix.) 
           *39           Mandatory checksum 
 

GPRMC - Recommended minimum specific GPS/Transit data 
This sentence includes the minimum recommended GPS data and includes the position 
(latitude and longitude), speed (in knots), date and time. 
 
$GPRMC,225446,A,4916.45,N,12311.12,W,000.5,054.7,191194,020.3,E*68 
 
           225446        Time of fix 22:54:46 UTC 
           A             Navigation receiver warning A = OK, V = warning 
           4916.45,N     Latitude 49 deg. 16.45 min North 
           12311.12,W    Longitude 123 deg. 11.12 min West 
           000.5         Speed over ground, Knots 
           054.7         Course Made Good, True 
           191194        Date of fix  19 November 1994 
           020.3,E       Magnetic variation 20.3 deg East 
           *68           Mandatory checksum 
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Glossary 
 

Almanac 
Data 

Contains information about the location of the GPS satellites and their orbital 
information at any time. 

Ephemeris 
Data 

Contains information about the status of the satellite, current date and time. 

GMT Greenwich Mean Time 
GPS Global Positioning System 
GPSr Global Positioning System Receiver 
NMEA National Marine Electronics Association 
UTC Coordinated Universal Time 
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The Menu System V1.3.1 
The menu system is used to configure the X200 and gives control over recording resolution, 
camera sequencing, timer settings, alarm triggering and alarm triggered recording. There is 
also access to monitor options and password functions along with many other parameters.   
 
A menu can contain the following types of entry: 
 
• Sub-menu heading - press the right arrow menu key and the sub-menu is entered. 
• Function - press the right arrow menu key and the function is performed (e.g. Reset 

System). 
• Selection - press the left and right menu keys to cycle through the choices. 
• Numeric item - input numbers 0 to 9 on the keypad (e.g. entering a time) and use the DEL 

button to correct mistakes. 
 
Any changes made to the menu system have immediate effect on the operation of the system.  
The menu is stored on non-volatile Flash memory inside the X200.  To revert to the factory 
settings run a RESET MENU TO THE FACTORY DEFAULT STATE WITH: ENGLISH 
LANGUAGE function in the RESET SYSTEM menu. 
 

Help Screens 
Every menu and every item within the menu has a separate help screen.   Place the cursor 
against the chosen item and press the HELP key.  Where multiple pages of help are available, 
move from one to the next by pressing the HELP key.  Use the MENU EXIT key at any time to 
leave the help menu. 
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Menu Navigation 
The menu system on the X200 can be accessed by using the X201 Reviewer. Connect the 
dedicated 8 way (Ethernet style) cable (supplied with X201) to the recorder and consult the 
instructions for X201 Reviewer. 
 
 
 

 
 
 
 
Press any of the 4 menu buttons to enter the main menu.  Once in the menu system, their 
function is as follows: 
 

Move arrow cursor up to the next item. 
 

Move arrow cursor down to the next item. 
 
If the arrow cursor is currently at a menu selection, 
(e.g.  RESOLUTION: > HIGH),  
pressing the left button will cycle the value backwards,        
(e.g. to  RESOLUTION: > MEDIUM),  

 
  If the arrow cursor is currently at a menu selection  
  (e.g.  RESOLUTION: > LOW),  

pressing the right button will cycle the value forwards, 
  (e.g. to  RESOLUTION: > MEDIUM). 
   

If the arrow cursor is currently at a sub-menu title 
  (e.g.  > OTHER OPTIONS). 
  pressing the right button will enter this sub-menu. 
 
The MENU EXIT key on the X201 Reviewer will exit the current menu and move up 1 level in 
the menu system when pressed.  If already at the top level of the menu pressing this key will 
exit the menu system completely and return to the video switcher. 
 
If the left and right menu keys have no effect, then numerical entry using keys 0 to 9 is 
required.   
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The SEARCH key on the X201 Reviewer accesses a menu allowing the user to go to a specific 
time and date in the recorded footage. Pressing this button will enter the PLAYBACK SEARCH 
screen as seen below. If the footage on a given camera cannot be found (it may not have been 
recorded), a "NO FOOTAGE FOR SELECTED CAMERA" message will be displayed.   
 
 
 

     PLAYBACK SEARCH 
 
           TIME :    00 : 00 
 DATE :  00 / 00 / 00 
 
 PLAY FROM SET TIME DATE 
 
 PLAY OLDEST 
 PLAY NEWEST 
 
 
 
 PRESS MENU EXIT TO EXIT MENU 
     
        
 
• TIME – Use the number keys to enter a time in 24hr format. 
 
• DATE – Use the number keys to enter a date in the format DD/MM/YY 
 
• PLAY FROM SET TIME DATE – Plays the footage beginning from the time and date 

entered. If there is no footage at the time specified a jump is made to the nearest footage to 
the time given. 

    
• PLAY OLDEST – Plays the oldest available footage on the Hard Disk Cartridge. 
 
• PLAY NEWEST – Plays the most recent footage available on the Hard Disk Cartridge. 
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Main Menu 
 
 
 

MAIN  MENU             
                                    
          OTHER   MENU                
          NORMAL  RECORDING           
          TIMER   RECORDING           
          SHOT    RECORDING 
  AUDIO   RECORDING           
          ALARM   RECORDING           
          ALARM   INPUTS              
          ALARM   OUTPUT / LEDs             
          VIDEO   SWITCHER 
 
    
 
 
 
Sub-menus available from the MAIN MENU: 
 
• OTHER MENU – Leads to the other menu items. 
• NORMAL RECORDING – Default recording set-up activated by the record on/off button. 
• TIMER RECORDING – Recording set-up activated by the inbuilt weekly interval timer. 
• SHOT RECORDING – Shot Recording set-up activated by specified alarm inputs. 
• AUDIO RECORDING – Set-up for audio recording. 
• ALARM RECORDING – Recording set-up activated by the alarm inputs. 
• ALARM INPUTS – Sets the open/closed conditions and actions for each of the 4 alarm 

inputs. 
• ALARM OUTPUTS – Sets the open/closed condition and triggers for the alarm output.  Sets 

the conditions for the external LED outputs. 
• VIDEO SWITCHER – Sets the dwell times of individual or groups of cameras. 
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Other Menu 
 
 
 

OTHER  MENU             
                                    
          FILES 
  PASSWORD 
  TIME AND DATE 
  CAMERA TEXT 
  FILE SYSTEM 
  LAN 
  GPS 
  STATISTICS 
  ADVANCED  
  RESET 
 
    
 
 
Sub-menus available from the OTHER MENU: 
 
• FILES – Allows listing and access to all recordings on the Hard Disk Cartridge. 
• PASSWORD – Settings for password protection and change password facility. 
• TIME AND DATE – Change the system time and date plus summertime correction. 
• CAMERA TEXT – Text labels for each camera can be entered in this menu. 
• FILE SYSTEM – File organisation and health check. 
• LAN – Set-up for LAN connection. 
• GPS – Set-up to confirm connection of GPS device and format of GPS data. 
• STATISTICS – General recoding and system statistics. 
• ADVANCED – Advanced options. 
• RESET – Reset recordings and/or return menu to factory default settings. 
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Files Menu 
 
 
 

     FILES             
     >FIRST   /   LAST PAGE 
       PAGE  1 OF 1 
 
 W 00:20:00 01/01/04 
 W A 00:10:00 01/01/04 
 00:00:00 01/01/04 
           
 
    
 
 
 
 
 
 
The files menu lists the files that are recorded on the Hard Disk Cartridge and allows the user 
to write-protect or remove write-protection for any file and provides instant jump to any file.  The 
file listing is displayed on a number of pages with each page showing up to 10 files. 
 
• FIRST / LAST PAGE 
Use the left menu button to view the first page of the file listing.  Use the right menu button to 
view the last page of the file listing. 
 
• PAGE 
Use the right menu button to advance to the next page of the file listing and the left menu 
button to move back to the previous page of the file listing.  The current page and the total 
number of pages will be shown by ‘x‘ OF ‘x‘.  For example 1 OF 10 would indicate that page 1 
is being shown out of a total of ten pages. 
 
File Listing 
The file listing shows files most recent first.  Files marked with an ‘A’ indicate that it is an alarm 
recording and ‘W’ indicates that the file is write protected.  In the above menu example there 
are 2 normal recording files and 1 alarm event file which has been write protected.  All files are 
10 minutes in duration. 
 
Voluntary Write-Protection  
Any file can be write-protected to avoid it being erased on loop recording.  For example there 
may be some critical footage that needs to be kept but the user may want to continue recording 
on the same disk once he has protected this file.  To write protect any file move the arrow 
cursor next to it in the file listing and press the left menu button, “W” will then appear next to the 
file showing that it is protected.  Write-protection can be removed by pressing the left menu 
button again.  In the above example the file 00:20:00 has been voluntarily write-protected.  
Pressing the left menu button again removes write-protection (the left menu button toggles the 
write protect status).  Write-protected files appear as write-protected (read only) on the PC.  
You can change the write-protect status either on the PC or as explained on the X200.  Any 
files that are not write-protected on the X200 get overwritten (oldest first) during the process of 
recording.   
 
Jump to File 
Press the right menu button to jump to the start of the file indicated by the arrow cursor. 
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Password Menu 
 
 
 

PASSWORD             
      
            PASSWORD REQUIRED FOR : 
   
 RECORD:  NO 
 MENU:   NO 
 SWITCHER:  NO 
 PLAY:   NO 
           
 
   >CHANGE PASSWORD  . . . 
 
 
 
 
 
The password menu restricts user access to the four key parts of the system. Here is a 
summary of the menu selections available: 
 
• RECORDING - If set to YES, the record button is password protected.  
 
• MENU - If set to YES, access to the menu system is password protected.  
 
• SWITCHER - If set to YES, the button to activate auto switcher mode is password 

protected.  
 
• PLAY - If set to YES, the controls to review recorded footage are password protected. 
 
If the user tries to access a protected function, he is asked to type in the password.  The default 
password is 0000 when shipped.  On correct password entry (four digits e.g. 3524 or 8912) the 
password protection is temporarily disabled.  It is reinstated after 1 minute of no key presses.  
Protection is also automatically reinstated when leaving the password menu. 
 
• CHANGE PASSWORD - The supervisor who knows the password is requested to type in 

the old password, followed by the new one.  He is then requested to retype the new 
password.  If he has done this successfully the new password is made the current one and 
the password protection is activated.  

 
Hints 
 
It is intended in a password protected system to at least protect the menu system.  This 
ensures that important operating settings cannot be tampered with.  Other protection may be 
required e.g. the record button may be disabled.  Some examples are given overleaf.  
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Examples 
 

Selection Set to 

RECORDING YES YES NO 

MENU YES YES YES 

SWITCHER YES NO NO 

PLAY YES NO NO 

Result: Full protection - no 
functions available.

Allow the user to 
review footage and 
look at live cameras 

only. 

Allow the user to 
carry out basic 

functions, but without 
access to any menus. 

 
 
 
The password for the unit when the unit is shipped is 0000.  This may be changed as described 
previously. 
 
In the event of complete password lockout contact your installer / distributor for a code for the 
X201 Reviewer.  The user can enter a code on the X201 Reviewer which will enable him to 
reset the unit and reset the password. 
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Time and Date Menu 
 
 
 

        TIME AND DATE             
      
            TIME:           > 00 : 00 : 00 
 DATE:  01 / 01 / 04 
 MODE  DD/MM/YY 
   
 SET CLOCK TO THESE SETTINGS  . .  
 
 
 SUMMERTIME ADJUST: UK 
 SUMMER / WINTER TIME: WINTER 
 
 
 
 
 
The time and date menu sets up the date, time and seasonal correction. 
 
• TIME - Type a time using the numbered keys.  Invalid times are prohibited 
 
• DATE - Type a date using the numbered keys. Invalid dates are prohibited 
 
• MODE – Use the left and right menu buttons to toggle the format the date is displayed in 

between DD/MM/YY and MM/DD/YY. 
 
• SET THE CLOCK TO THESE SETTINGS - Press the right menu button to set the time and 

date as entered above. 
 
You must use leading zeros for the time and date where necessary, e.g. 09:45 and 04/07/98.  
The unit is shipped from the factory with date and time set to GMT (UCT). 
 
• SUMMER TIME ADJUST - Set this to OFF if you do not want the unit to automatically 

correct for daylight saving time.  Select UK /  EUR / USA for the unit to automatically adjust 
for daylight saving time in the UK, Central Europe or USA. 

  
UK - At 1:00 am on the last Sunday in March the clock is put forward 1 hour (summer time) 
At 2:00 am on the last Sunday in October the clock is put back 1 hour 
 
EUR  - At 2:00 am on the last Sunday in March the clock is put forward 1 hour (summer 
time) At 3:00 am on the last Sunday in October the clock is put back 1 hour 
 
USA - At 2:00 am on the first Sunday in April the clock is put forward 1 hour   (summer time) 
At 3:00 am on the last Sunday in October the clock is put back 1 hour 
 

Summer Time Adjust is automatically applied even if the unit is switched off during the time at 
which the clocks go forwards or backwards.  In the latter case correction is applied on power-
up.  A message is displayed indicating to the user that the time has been modified. 
 
The Current time period is shown as either SUMMER or WINTER at the bottom of the menu 
screen. 
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Camera Text Menu 
 
 
 

        CAMERA    TEXT         
      
          CAM            CAM 
 1    C210KHD DOOR 2    C210KHD FRNT 
 3    C210KHD REAR 4    C210KHD DRVR 
 5   6 
 7   8 
 9   10 
 11   12 
 13   14 
 15   16 
  
     DUPLICATE TEXT FROM CAM 1  .  . 
           TIMESTAMP POS:   > BOTTOM LOW 
 
 
Allows the user to create an optional text label of up to 12 characters per camera. 
 
Use the up and down ‘MENU’ arrow keys to move to the previous or next camera.  Use the 
numbered keys on the X201 reviewer to cycle through the available characters for that key and 
the left & right ‘MENU’ arrow keys to move the highlighted cursor to the previous or next 
character respectively.   
 
The numbered keys have the following 4 characters attached to them, pressing the key 
repeatedly will cycle through the 4 available characters.  The fifth character on each key is a 
blank space; use this to delete any unwanted characters. 
 
Key Number/Characters 
1 A B C 1  (space) 
2 D E F 2  (space) 
3 G H I  3  (space) 
4 J K L  4  (space) 
5 M N O 5 (space) 
6 P Q R 6  (space) 
7 S T U 7  (space) 
8 V W X 8 (space) 
9 Y Z 9   (space) 
0 0   (space) 
 
Keep pressing keys 0 to 9 until the desired character appears. For example pressing key '1' 
gives the 'A' character, pressing again, the 'B' character, again the 'C' character, again the '1' 
character and finally the SPACE character.  The sequence repeats. 
The camera text will appear above the time stamp on each image.  Like the time stamp it is 
embedded into each image and cannot be removed from the image. 
 
• DUPLICATE TEXT FROM CAM 1 – Copies the current text from camera 1 to all other 

cameras.  Move the arrow cursor next to this option and press either the left or right menu 
buttons to copy the text.  This avoids repeat typing of vehicle registration numbers or other 
common text. 
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• TIMESTAMP POS: - The position of the timestamp can be moved to either bottom 
low/bottom-mid/bottom-high which are 3 positions below the main image or top-low/top-
mid/top-high which are 3 positions above the main image.  Select NO TIMESTAMP if you 
do not wish to see a timestamp on the recorded images. 

 
A typical time stamp is shown below with camera text: 
 
 
Camera Text 

 
JKN456Y DOOR  

 
 

Camera    Time                    Date              
C1 12:00:00 27/07/01

Number                    
 
 
The camera number indicates which camera grabbed the image, and the time and date 
indicate when the image was grabbed.  
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File System Menu 
 
 
 

        FILE      SYSTEM      
     
 RECORDING MODE : >LOOP RECORD 
  

FILE LENGTH :  10 MINUTES 
  

FILENAME TEXT : 
  

WRITE PROTECT ALARM REC : NO 
WRITE PROTECT  SHOT  REC : NO 

 
FILE SYSTEM CHECK MENU  .  . 

 
 
 
 
 
The file system menu controls how files are laid onto the disk. 
 
• RECORDING MODE- Sets either LOOP RECORD (oldest files will be overwritten first when 

Hard Disk Cartridge is full) or SINGLE PASS recording (recording will stop when Hard Disk 
Cartridge is full). 

 
• FILE LENGTH – 10 MINUTES / 1 HOUR 

This controls how often new files are created, set the file length as appropriate.  The 1 hour 
setting is useful if you are recording over a long period of time and it is desirable to have a 
smaller number of files to manage or archive.  The 10 minute setting gives more files but 
each is of a small size and this may help in searching for specific short duration events.   

 
• FILENAME TEXT – Enter up to 12 characters of text that will appear at the start of all files.  

For mobile applications a vehicle registration number could be used.  The X200 serial 
number could also be used. 

 
This improves the audit trail.  Please note that the filename and serial number are buried  
into each file for audit trail purposes and can be verified. 

 
• WRITE PROTECT ALARM REC – Select whether alarm recording files are write protected.  

If alarm recording files are write protected they will not be deleted on loop recording (LOOP 
RECORD setting). 

 
To remove write-protection either use the files menu and the left menu button (toggle ‘W’  
status) or delete all recordings via the reset menu. 

 
• WRITE PROTECT SHOT REC – Select whether shot recordings are write protected.  This 

is the same as per the WRITE PROTECT ALARM REC function but only affects shot 
recording files. 

 
• FILE SYSTEM CHECK MENU – Accesses the file system check menu. 
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File System Check 
 
 
 

    FILE  SYSTEM CHECK      
     
  ON POWER SWITCH ON : 

CHECK AND CORRECT 
CREATE SYSTEM LOG 

   
     PERFORM CHECK ONLY NOW 
 
     PERFORM CHECK AND CORRECT NOW 
 
 
 
 
 
 
 
 
This menu sets the default file checking and correcting action on switch on and can be used to 
check and/or correct files manually at any time. 
 
• ON POWER SWITCH ON 
 

NO CHECK / CHECK ONLY / CHECK AND CORRECT – Gives the option to check the file 
system at power on and optionally correct any errors.  This is the recommended option as 
the X200 will check and correct both the file system and FAT of the Hard Disk Cartridge on 
start-up. 
 
CREATE SYSTEM LOG / DO NOT CREATE SYSTEM LOG – Determines whether a 
system log file is created and copied to the Hard Disk Cartridge when the X200 is powered-
up.  This file can be used by Timespace Technology as a diagnostic file to check system 
performance.  It is highly recommended that the default option of CREATE SYSTEM LOG is 
used. 

 
• PERFORM CHECK ONLY NOW – Pressing the right menu button will perform a file system 

check. 
 
• PERFORM CHECK AND CORRECT NOW – Pressing the right menu button will perform a 

file system check and fix any errors that are found. 
 
 
 
 
 
 
 
 
 
 

54 

In
te

llig
en

t S
ec

ur
ity

 &
 F

ire



LAN Menu 
 
 
 

              LAN    
     

IP ADDRESS :         > 10. 0. 0 . 200 
 
SUBNET MASK : 255 . 255 . 255 .        0 
 
GATEWAY :  10. 0. 0 . 255 
 
   PING TEST   .  .  . 
 
 
MAC :      0 0 : 0 F : B 4 : 0 0 : 0 0 : 0 0 

 
 
 
 
• IP Address – For devices communicating on a network, messages must identify the source 

and destination with an address.  The IP (internet protocol) address is a 32-bit number that 
uniquely identifies a device connected to the network and is usually represented in a dotted 
decimal form. 

 
 e.g.  10.0.0.28 
 

Use the right and left menu arrow keys to move across the input fields and the number keys 
to input the address. 

 
• Subnet Mask – The subnet mask is used to determine what subnet an IP address belongs 

to. An IP address has two components, the network address and the host address.  
Subnetting enables a network administrator to further divide the host part of the address into 
two or more subnets. In this case, a part of the host address is reserved to identify the 
particular subnet.  

 
The subnet mask is the network address plus the bits reserved for identifying the sub 
network. (By convention, the bits for the network address are all set to 1.)  As a mask, it can 
be used to identify the subnet to which an IP address belongs by performing a bitwise AND 
operation the mask and the IP address. The result is the sub network address.  

 
Use the right and left menu arrow keys to move across the input fields and the number keys 
to input the address. 

 
 
• Gateway – This is the address of the ‘gateway’ in a network that a computer will use to 

access another network if a gateway is not specified for use.  In a network using subnets, it 
is the address of the router that forwards data traffic to a destination outside of the subnet of 
the transmitting device.  

 
Use the right and left menu arrow keys to move across the input fields and the number keys 
to input the address. 
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• Ping Test ... – Selecting this option by pressing the right menu button will bring up the ‘ping 
test’ menu which is shown below.  

 
        PING TEST                   
 
   PING ADDRESS:   10.  0.  0.  1 
 
 
   >DO PING TEST REPLY RECEIVED 
 
 
   BYTES SENT:                3988 
   BYTES RECEIVED:      5304 
 
 
 

 
Enter the destination IP address of the unit you want to test communication with on the ping 
address line by using the left and right menu buttons to move across the fields and the 
number keys and then select DO PING TEST ....  If the destination receives the ping 
message and replies within 10 seconds then REPLY RECEIVED is displayed; otherwise 
‘NO REPLY’ is displayed. 

 
The BYTES SENT and BYTES RECEIVED fields update in real-time to show how many 
bytes are being transferred to and from the X200 and can provide further indication of data 
transfer. 

 
• MAC – All network devices include a unique media access control (MAC) address used to 

identify it on a network.  The address is a 48 bit number, usually represented as 6 bytes – 
each byte written in hexadecimal notation. 

 
All Timespace Technology devices have a MAC address which begins 00 0F B4 followed by 
another three bytes. 

 
e.g.  00 0F B4 00 0A 48 

 
The X200 LAN menu option allows the user to display its MAC address which may be useful 
in configuring access control with wireless networks. 
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GPS Menu 
 
 
 

                 GPS    
     
 EMBED GPS POSITION :  NO 
 EMBED GPS SPEED :  NO 
 SPEED UNITS :  MPH 
 
 SYNC  CLOCK WITH GPS : NO 
 
 
  
 NO GPS CONNECTED 
 
 
 
 
 
• Embed GPS Position – Selecting YES will cause the position information to be embedded 

in the recorded image. 
 
• Embed GPS Speed – Selecting YES will cause the speed information to be embedded in 

the recorded image. 
 
• Speed Units – Select either KPH for kilometres per hour or MPH for miles per hour. 
 
• Sync Clock with GPS – The X200 Digital Recorder includes a clock which is used to 

timestamp recording files and overlay the date and time on recorded images.  Although 
accurate, the system can be configured to synchronize the clock with the date and time 
information received from the GPS receiver.   

 
Synchronization only occurs when the X200 is powered up and before it starts recording.  At 
this time the built-in clock may be corrected by a maximum of 20 seconds if a previous 
discrepancy has been detected between the internal time and the GPS receiver time. 

 
Selecting YES will synchronize the X200 clock on power up.  The time received from the 
GPS receiver is always UTC (Coordinated Universal Time) which is the same as GMT 
(Greenwich Mean Time). 

 
The current status of the attached GPS device (mouse) is show at the bottom of the screen 
which indicates whether it is connected and able to lock to the GPS satellites. 
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Statistics Menu 
 
 
 

           STATISTICS    
     
             OPERATING SYSTEM:     1.0 
 

HARD DISK : 
20.0  SIZE IN GIGABYTES 
50%  USED 
20%  WRITE PROTECTED 

 
31  FILES 
01 / 01 / 04 START DATE 
31 / 01 / 04 END DATE 
31.0  DAYS RECORDING 

 
 
 
 
The statistics page gives the operating system version number, disk size, percentage used and 
percentage write protected. Recording statistics are updated every minute and are intended to 
be used for monitoring a camera system and to provide an indication of the capacity of the 
X200 in different recording environments.  
 
The total number of files along with the start date, end date and total amount of days recording 
are shown. 
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Advanced Menu 
 
 
 

           ADVANCED 
          > USE RECORD STATE AT POWER OFF 
 ENABLE X200 RECORD BUTTON:  YES 
 
 LOAD SYSTEM UPGRADE  .  . 

SAVE SYSTEM UPGRADE  .  . 
 
 RECORDING MODE FOR : 
    NORM / TIMER: >COND. REFRESH 
    ALARM / SHOT:   FULL UPDATE 
 VIDEO STANDARD:   PAL 
 MODEM LOOPBACK TEST 
 H/W VER: 16AE  SERIAL NUMBER: 42 
 
 
The advanced menu provides control over more sophisticated X200 functions. 
 
• USE RECORD STATE AT POWER OFF / 

DO NOT RECORD AT POWER UP / 
RECORD AT POWER UP 
 
The default setting USE RECORD STATE AT POWER OFF means that if the unit was 
recording when it was switched off it will record when it is switched back on.  Also if the unit 
wasn’t recording when it was switched off it won’t be recording when it is switched on.  This 
setting is generally convenient for covert use where recording is switched on and off by 
pressing the record button and the unit continues the way it left off. 
 
The DO NOT RECORD AT POWER UP setting is useful if manual adjustments need to be 
made to the menu settings every time the unit is switched on prior to recording.  Note that 
the unit will not do normal recording after a loss of power e.g. in a power cut so this setting 
should be used with caution. 

 
The RECORD AT POWER UP setting should be used if the unit is always to do normal 
recording on power up.  This is important in vehicle applications where the user may have 
inadvertently switched the unit off in a non-recording state (e.g. he has just been playing 
back some footage and he switched off recording to make this easier).  With this setting 
however the unit is left at switch off, it will record the next time it is powered up. 

 
• ENABLE X200 RECORD BUTTON – If set to YES the ‘Record’ button on the front of the 

X200 will switch Normal Recording on and off.  If set to NO this button is disabled. 
 
• LOAD SYSTEM UPGRADE – This loads a new version of the X200 operating system from 

the Hard Disk Cartridge.  Do the following. 
 

Delete all recordings on the Hard Disk Cartridge using the reset menu. 
Using the USB interface kit copy the new .xos file from the PC to the Hard Disk Cartridge. 
Right click the .xos file on the Hard Disk Cartridge and select properties. 
Left click to tick the ‘Read-only’ box at the bottom of the properties window and click OK. 
Insert the Hard Disk Cartridge into the X200 and stop it recording if it is currently doing so. 
Run LOAD SYSTEM UPGRADE by pressing the right menu button. 
 
Check the software version in the statistics menu to verify the new version has been loaded. 
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• SAVE SYSTEM UPGRADE – This saves the X200 operating system and current menu 
settings to the Hard Disk Cartridge as a .xos file. 

 
The Cartridge can then be used as a master to set up another X200 with the same software  
version and menu settings.  Use LOAD SYSTEM UPGRADE on the other X200 with the  
master Cartridge inserted. 
 

• RECORDING MODE FOR: 
 
NORM / TIMER :  
ALARM / SHOT : 
 
COND. REFRESH / FULL UPDATE – The recording mode is selectable for normal and  
timer recording and also for alarm and shot recording. 
 
Specify FULL UPDATE to record full image information or CONDITIONAL REFRESH to 
record only the parts of the image that have changed. 
 
In most cases conditional refresh will be the preferred option as the file size on disk is  
reduced from that required for full update. 
 

• VIDEO STANDARD 
 

PAL / NTSC – After moving the cursor down the Video Standard line, the user can use the 
cursor keys to select between PAL and NTSC.  Once the appropriate selection has been 
made the unit must be power-cycled before it comes into effect.  During the power up 
sequence, the X200 will briefly display the software version installed along with the 
configured video standard. 

 
 Please refer to the PAL / NTSC Switching section of this manual for further information 

about using the X200 in PAL and NTSC configurations. 
 
• MODEM LOOPBACK TEST 
 

The modem loop back test checks that the internal X200 hardware is functioning correctly 
so that it can be successfully used with an external modem.  A special female 9-way D 
socket is required with pins 2 & 3 connected together and pins 1, 7 & 8 connected together.  
This is connected to the male RS232 socket on the rear panel of the X200 before 
conducting the modem loop back test.  The RS232 connector is detailed in the Connector 
Specifications section of the X200 manual. 
 
To start the test press the right menu button.  If PASS is shown on the menu screen next to 
the MODEM LOOPBACK TEST then the internal hardware is functioning correctly. 

 
The hardware version (H/W VER) and serial number of the X200 are also shown at the bottom 
of the menu screen for reference. 
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Remote Settings Menu 
 
 
 
                              REMOTE SETTINGS 
 
         > SMS OPTIONS     
  
 LAST SMS SENT    :    UNKNOWN 

MODEM NOT AVAILABLE      
           CALLS  RECV  000 
 SMS RECV  000 
 SMS SENT  000 
 SMS ERRORS  000 
 
 
 RESET MODEM 
 SEND SMS NOW 
 
The remote settings menu provides information about a connected GSM modem as well as 
operational statistics and SMS options. 
 
• SMS OPTIONS 
 

Enters the SMS OPTIONS sub-menu. 
 
• LAST SMS SENT 
 

The date of the last SMS sent from the X200. 
 
• MODEM IN AUTOANSWER MODE / MODEM NOT AVAILABLE 
 

Shows whether a GSM Modem is attached and setup correctly in auto answer mode. 
 
• CALLS RECV 
 

The number of calls received by the GSM Modem attached to the X200. 
 
• SMS RECV 
 

The number of SMS text messages received by the X200. 
 
• SMS SENT 
 

The number of SMS text messages sent by the X200. 
 
• SMS ERRORS 
 

The number of failures to send an SMS text message at the user defined intervals. 
 
• RESET MODEM 
 

Resends the setup commands to reset a connected GSM Modem. 
 

• SEND SMS NOW 
 
Tests the GSM/SMS connection by sending a user defined message to the phone number 
selected in the SMS OPTIONS menu. 
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SMS Options Menu 
 
 
 
             SMS MESSAGE OPTIONS 
 
           SEND  SMS           > NEVER 
 PHONE NUMBER  
 MSG LINE 1 
 MSG LINE 2 
 MSG LINE 3 
 MSG LINE 4 
 
 

 

 
The SMS options menu allows the user to specify the phone number for the SMS text message 
to be sent to, the contents of the SMS text message and how frequently it will be sent.  
 
• SEND SMS 

 
NEVER / MONTHLY / WEEKLY / DAILY / POWER UP – Determines how often the X200 
will send the user defined SMS text message.  It is possible to select once per month, week, 
day or every time the X200 is power-cycled. 
 

• PHONE NUMBER 
 
The number keys on the Reviewer are used to enter the phone number to which the SMS 
text message will be sent.  Do not leave any spaces in the phone number. 
 

• MSG LINE 1 / 2 / 3 / 4 
 
The text to be sent is entered using the number keys 1-9 on the Reviewer; up to four lines of 
text can be entered.  Use the left and right menu buttons to move to the previous or next 
character on each line respectively.  Use the up and down menu buttons to move to the 
previous or next line of text respectively. 
 
Key  Number/Characters 
1  A B C 1  (space) 
2  D E F 2  (space) 
3  G H I  3  (space) 
4  J K L  4  (space) 
5  M N O 5 (space) 
6  P Q R 6  (space) 
7  S T U 7  (space) 
8  V W X 8 (space) 
9  Y Z 9   (space) 
0  0   (space) 
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Reset System Menu 
 
 
 

       RESET SYSTEM 
     
          > DELETE ALL RECORDING FILES  
 
 RESET MENU TO FACTORY   
 DEFAULT STATE 
   

MENU LANGUAGE: ENGLISH 
 
 
 
 
 
 
 
 

 
• DELETE ALL RECORDING FILES – Removes all recordings from the hard disk including 

write-protected files.  Only do this if you want to completely remove all recordings from the 
hard drive as there is no undo option.  Press the right menu button to go to a warning 
screen, pressing the right menu button again will carry out this action whilst pressing the 
MENU EXIT button will abort this procedure. 

 
• RESET MENU TO FACTORY DEFAULT STATE – Pressing the right or left menu button 

will immediately reset the entire X200 menu system to its default settings.  Please note that 
there is no undo option.   

 
• MENU LANGUAGE – Sets the language that the menu is displayed in. 
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Normal Recording Menu 
 
 
 

   NORMAL RECORDING 
     
       CAMERAS  IMAGES / SEC       RESOLUTION 
   
 1   TO    4       > 5   HIGH 
 2   TO    16 NO RECORDING LOW 
  
        
        RECORD ALL SPECIFIED CAMERAS 
  COL   B&W     01   02   03   04   05   06   07   08 
              09   10   11   12   13   14   15   16 
 
 
        20 IMAGES / SEC OUT OF 25 MAX 
  
 
This menu sets the images per second and image resolution recorded by each camera during 
normal recording. 
 
• CAMERAS – Use the up and down menu buttons to move between items in the menu.  

Pressing the right and left menu buttons next to a camera group will increase or decrease 
the number of cameras in that group respectively. 

 
Please note that this applies to the X200-16.  The X200-04 lists each of the 4 cameras 
separately. 

 
• IMAGES / SEC  
 

NO RECORDING / 0.1 / 0.2 / 0.3 / 0.4 / 0.5 / 0.6 / 0.7 / 0.8 / 0.9 / 1.0 / 1.2 / 1.5 / 2.0 / 2.5 / 
3.0 / 4.0 / 5.0 / 6.0 / 7.0 / 8.0 / 9.0 / 10 / 12 / 15 / 20 / 25 / MAX RATE- This sets the number 
of images per second to be recorded by a camera during normal recording up to a total of 
25 images per second for all cameras added together.  If MAX RATE is selected then the 
X200 will automatically adjust the images per second for each of the specified cameras so 
that the total is equal to 25 images per second. 

 
• RESOLUTION – This can be set to: 
 

LOW – This sets the highest level of compression.  Although file sizes will be comparatively  
small, visible blocking artefacts may be seen. 
MEDIUM – This sets the medium compression level, images with little loss of quality which  
will be adequate for most applications. 
HIGH – This sets a medium-low level of compression with gains in image quality over 
medium resolution but with larger file sizes. 
V.HIGH – This sets the lowest level of compression with the best image quality but the 
largest file sizes. 
 

• RECORD ALL SPECIFIED CAMERAS 
 ONLY RECORD CONNECTED CAMERAS 

 
This sets whether the X200 will record on all cameras specified in the recording parameters 
shown at the top of the menu screen or whether the X200 will only record on connected 
cameras shown as highlighted on the connected camera list 01 – 16 at the bottom of the 
menu screen (01 – 04 on the X200-04). 
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• COL B&W 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 
 

The connected camera list highlights all connected cameras in either red or white to indicate 
that either a colour (red highlight) or black and white (white highlight) camera is connected 
to the corresponding input number. 

 
• X IMAGES / SEC OUT OF 25 MAX – This displays how many images per second will be 

recorded during normal recording out of the X200 25 images per second maximum limit.  
Although less than 25 images per second can be recorded, the X200 is not able to record 
more than 25 images per second. 

 
If the maximum of 25 images per second is exceeded by the sum of all the cameras then 
the X IMAGES / SEC OUT OF 25 MAX text will change to red as a warning.  If this is not 
corrected then the X200 will still record but it will automatically adjust the images per second 
for each camera so that the total does not exceed 25. 

 
In the example menu screen shown above cameras 1 – 4 have been set to 5 images per 
second.  This gives a total sum of 20 images per second out of the available 25. 
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Timer Recording Menu 
 
 
 

     TIMER RECORDING 
     
       CAMERAS  IMAGES / SEC       RESOLUTION 
   
 1   TO    4       > 5   HIGH 
 2   TO    16 NO RECORDING LOW 
       
 
      SET TIMER START / STOP TIMES    .  .  . 
      WHEN TIMER STOPS :     STOP REC. 
 
      20 IMAGES / SEC OUT OF 25 MAX 
  
 
 
This menu sets the images per second and image resolution recorded by each camera during 
timer recording.  Preference for times of recording and dates to be excluded can also be set in 
the ‘timer recording times’ sub-menu accessible from this menu. 
 
Use the up and down menu buttons to move between images per second and resolution for 
each camera and the left and right menu buttons to scroll between the options.  Pressing the 
right menu button next to SET TIMER START / STOP TIMES accesses the timer recording 
times sub-menu. 
 
• CAMERAS – Use the up and down menu buttons to move between items in the menu.  

Pressing the right and left menu buttons next to a camera group will increase or decrease 
the number of cameras in that group respectively. 

 
Please note that this applies to the X200-16.  The X200-04 lists each of the 4 cameras 
separately. 

 
• IMAGES / SEC – These settings are the same as described in the normal recording menu, 

except they apply only during timer recording. 
 
• RESOLUTION – These settings are the same as described in the normal recording menu, 

except they apply only during timer recording. 
 
• SET TIMER START / STOP TIMES - Pressing the right menu button nest accesses the 

timer recording times sub-menu described on the next page. 
 
• WHEN TIMER STOPS – Pressing the left or right menu buttons chooses between STOP 

REC. and NORMAL REC.  This option decides whether the X200 will stop recording when 
the defined timer recording period has ended (STOP REC.) or whether it will continue 
recording in normal recording mode (NORMAL REC.). 

 
• X IMAGES / SEC OUT OF 25 MAX – This displays how many images per second will be 

recorded during timer recording out of the X200 25 images per second maximum limit.  This 
display is the same as found in the normal recording menu, except it applies only during 
timer recording. 
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Timer Recording Times Menu 
 
 
 

TIMER RECORDING TIMES 
 
          > IGNORE DAILY TIMES  
 MON 08:15 TO 17:00 COPY 
 TUE 08:15 TO 17:00 DOWN 
 WED 08:15 TO 17:00 
 THU 08:15 TO 17:00 
 FRI 08:15 TO 17:00 
 SAT 00:00 TO 00:00 
 SUN 00:00 TO 00:00 
 
 IGNORE PERIOD TIMES  
 FROM : 00:00  00 / 00 / 00 
 TO : 00:00  00 / 00 / 00 
     
        
  
The timer recording times menu sets the times that will be included or excluded for timer 
recording.  A period of exemption/inclusion can also be set by date.  This menu is a sub-menu 
of the timer recording menu and is accessed by pressing the right menu button next to the SET 
TIMER START / STOP TIMES option in the timer recording menu. 
 
• IGNORE DAILY TIMES  

RECORD BETWEEN DAILY TIMES  
RECORD OUTSIDE DAILY TIMES  

 
Use the right and left menu buttons to scroll between the available options.  The default 
setting IGNORE DAILY TIMES disables timer recording, the setting RECORD BETWEEN 
DAILY TIMES will mean that timer recording will automatically take place between the start 
(left hand time column) and end times (right hand time column).  The setting RECORD 
OUTSIDE DAILY TIMES does exactly the opposite with timer recording automatically taking 
place outside of the specified times. 

 
Setting the daily times and using the COPY DOWN function. 
 
Use the up and down menu buttons to move the arrow cursor up and down the list of start and 
end times for each day.  When the cursor is next to a particular start / end time use the 
numbered keys on the X201 reviewer to enter a time in 24hr clock format.  Please note that 4 
digits must always be entered so single digit hour times such as 8am must be entered as 08:00 
as per the normal 24hr clock.  To exclude any particular day from timer recording simply type in 
00:00 for both times as per SAT and SUN in the example above. 
 
The COPY DOWN function allows the current times set for MON to be copied to all other days 
on the list.  This avoids unnecessary repetition when entering timing periods where daily 
recording times are the same.  Once the times for MON have been copied to all other days they 
may be individually changed as per normal.  For instance in the above example the times for 
MON - 08:15 TO 17:00 – were copied to all other days using the COPY DOWN function and 
then SAT and SUN were individually set to 00:00 to exclude them from timer recording. 
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• IGNORE PERIOD TIMES 
RECORD INSIDE PERIOD 
RECORD OUTSIDE PERIOD  
 
This enables the user to set a period of time, by time and date which is to be 
excluded/included from the daily timer recording parameters.  Use the menu up and down 
buttons to move between the times and dates and enter the time or date using the number 
keys.  The time is in 24hr clock format and the date is in the format DD/MM/YY. 
 

Examples of Timer Recording 
 
The daily times and period times are able to work together or independently to record as and 
when required.  For example -  
 
Recording Monday to Friday from 9am to 5pm. 
 
Select RECORD BETWEEN DAILY TIMES and set the daily times on Monday to Friday from  
09:00 TO 17:00 and Saturday and Sunday to 00:00 TO 00:00.  Select IGNORE PERIOD  
TIMES to disable the calendar period function. 
 
Recording Monday to Friday from 9am to 5pm but not in the month of June in 2004. 
 
Select RECORD BETWEEN DAILY TIMES and set the daily times on Monday to Friday from  
09:00 TO 17:00 and Saturday and Sunday to 00:00 TO 00:00.  Select RECORD OUTSIDE 
PERIOD  in the calendar period function and set the FROM and TO as 00:00 01/06/04 and 
00:00 30/06/04 respectively.  This will prevent recoding from midnight on the first of June to 
midnight on the 30th of June 2004. 
 
Recording continuously for 3 weeks starting at 7am on the 21st of August 2004. 
 
Select IGNORE DAILY TIMES to disable the daily recording times (this is necessary as 
recording is to take place for 24hours a day during the calendar period).  Select RECORD 
INSIDE PERIOD and set the FROM and TO as 07:00 21/08/04 and 07:00 11/09/04 
respectively. 
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Shot Recording Menu 
 
 
 

     SHOT RECORDING 
 
           CAMERAS :            > ALARM IN MENU 
 
 RESOLUTION :   LOW 
 
 NUMBER OF SHOTS :  1 
 
 IMAGES / SEC :  1.0 
     
        
 
 
 
 
 
Shot recording allows a defined number of shots (images) to be recorded from an alarm input 
trigger. 
 
• CAMERAS – This takes the user to the alarm inputs menu in which they can which alarm 

inputs will be used as a trigger for shot recording and from which cameras to record images.  
Please see the section on the alarm inputs menu for a detailed description of the available 
settings. 

 
• RESOLUTION - These settings are the same as described in the normal recording menu, 

except they apply only during shot recording. 
 
• NUMBER OF SHOTS  

 
1 / 2 / 3 / 4 / 5 / 8 / 10  / 15 / 20 / 25 / 30 / 50 / 100 / 150 / 250 / 500 – This sets the number 
of shots to be taken from each camera during shot recording.  Use the left and right menu 
buttons to scroll from between 1 to 500 shots. 

 
• IMAGES / SEC – These settings are the same as described in the normal recording menu, 

except they apply only during shot recording. 
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Audio Recording Menu 
 
 
 

     AUDIO RECORDING 
 
 AUDIO RECORDING :           > OFF 
 
           INPUT 1 WITH :           ALL CAMERAS 
 INPUT 2 WITH :  CAMERA 1 
  
 SAMPLING RATE :  16 kHz  

SAMPLING RESOLUTION :  16 BITS 
RECORD INPUT RANGE : 1.00 Vrms 
INPUT 1 LEVEL : NOT RECORDING 
INPUT 2 LEVEL : NOT RECORDING 
 
PLAYBACK VOLUME :  HIGH 
  

 
• INPUT 1 WITH 

INPUT 2 WITH 
 

ALL CAMERAS / CAMERA 1 / CAMERA 2 / CAMERA 3 / CAMERA 4  / CAMERA 5  / 
CAMERA 6  / CAMERA 7  / CAMERA 8  / CAMERA 9  / CAMERA 10  / CAMERA 11  / 
CAMERA 12  / CAMERA 13  / CAMERA 14  / CAMERA 15  / CAMERA 16 – Associates 
audio inputs 1 and 2 with a specific single camera or with all cameras.  The X201 reviewer 
will play back the audio recorded for this input with the camera specified. 
 
Please note that this applies to the X200-16.  The X200-04 will only have cameras 1-4 
listed. 

 
• SAMPLING RATE – The X200 records audio at a sampling rate of 16 kHz. 
 
• SAMPLING RESOLUTION – The X200 records audio at a sampling resolution of 16 bits. 
 
• RECORD INPUT RANGE 
 

0.12 Vrms / 0.25 Vrms / 0.50 Vrms / 1.00 Vrms / 2.00 Vrms – This defines the maximum 
signal that can be accommodated before clipping occurs.  If distortion due to clipping is 
experienced, increase the audio input range. 
 
For good noise performance reduce the audio input range until clipping is experienced and 
then increase the range by one increment. 

 
• INPUT 1 LEVEL 
• INPUT 2 LEVEL 
 

This gives an indication of current audio input level for each channel whilst recording and 
will be of use when setting the record input range.  The level is given in both dB and as a 
percentage of the maximum input level before clipping.  NOT RECORDING will be shown if 
the X200 is not currently recording. 

 
• PLAYBACK VOLUME 
 

LOW / MEDIUM / HIGH / FULL / MUTE – Select the volume level for audio play back via  
the X201 Reviewer and the line-level output on the rear of the X200. 
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Alarm Recording Menu 
 
 
 

     ALARM RECORDING 
 
  CAMERAS IMAGES / SEC  RESOLUTION 
 
   1   TO   3     > 3   MEDIUM 
   4   TO   16 NO RECORDING LOW 
 
 
 
  ALARM INPUTS MENU   . . .  
   
  PRE – TRIG WRITE PROTECT: OFF 
  POST – TRIGGER RECORDING :  OFF 
 
 
 
Camera groups for alarm recording can be created, the number of images per second and 
resolution of recording can be set for each group. 
 
• CAMERAS – Use the up and down menu buttons to move between items in the menu.  

Pressing the right and left menu buttons next to a camera group will increase or decrease 
the number of cameras in that group respectively. 
 
Please note that this applies to the X200-16.  The X200-04 lists each of the 4 cameras 
separately. 

 
• IMAGES / SEC – These settings are the same as described in the normal recording menu, 

except they apply only during timer recording. 
 
• RESOLUTION – These settings are the same as described in the normal recording menu, 

except they apply only during timer recording. 
 
• ALARM INPUTS MENU – Pressing the right menu button enters the Alarm Inputs sub-

menu. 
 
• PRE – TRIG WRITE PROTECT  
 

OFF /  1 MIN / 2 MINS / 5 MINS / 10 MINS / 20 MINS / 30 MINS / 1 HOUR / 2 HOURS –  
All files recorded in the specified period before the alarm event are write protected (so they 
will not be overwritten during loop recording). 

 
• POST – TRIGGER RECORDING  
 

OFF / 5 SECS / 10 SECS / 20 SECS / 30 SECS / 45 SECS / 1 MIN / 5 MINS / 10 MINS / 20 
MINS / 30 MINS / 45 MINS / 1 HOUR / 2 HOURS – Alarm recording can take place only for 
the duration of an alarm event (OFF) or can continue for a specified period of time after the 
event has ceased. 

 
Therefore if an alarm input is only likely to be a momentary event but the ten minutes after 
that event are also important select 10 MINS for post trigger recording. 
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Alarm Inputs Menu 
 
 
 

        ALARM INPUTS 
 

  IN ACTIVE FUNCTION  CAMS 
 
  1      > CLOSED NONE    
  2 CLOSED NONE 
  3 CLOSED NONE 
  4 CLOSED NONE 
 
  CURRENT STATE :  CLOSED / OPEN 
 
 1  2  3  4 
            
     
        
 
The Alarm Inputs menu defines what the X200 will do when the 4 alarm inputs are either in a 
closed or open state.  Closed is defined as a connection to the ‘-‘ terminal of the X200 
input/output connector, whilst open indicates that no contact is being made. 
 
The 4 inputs are listed in order as shown in the screen shot above, for each of the 4 inputs the 
following options are available. 
 
• ACTIVE – Use the left and right menu buttons to toggle between CLOSED and OPEN.  This 

sets the state which triggers an alarm event and will cause the defined action to take place. 
 
• FUNCTION – This defines the action of the X200 when the selected alarm input is active. 
 

NONE – No action. 
 

NORM REC – Switches normal recording on and off instead of the X201 record button. 
  

ALARM REC – Sets the X200 to do alarm recording with the settings for images per second 
and resolution as defined in the Alarm Recording Menu.  The cameras to be recorded can 
be set in the right hand CAMS column by pressing the right and left menu buttons to raise or 
lower the current number respectively. 

 
In this way an alarm input can trigger recording on a single or a group or cameras.  Multiple 
alarm input triggers will cause camera ranges to be combined. 

 
SHOT REC – Sets the X200 to do shot recording with the settings defined in the Shot 
Recording Menu.  As per ALARM REC a single or group of cameras can be specified. 

 
SWITCHER – Sets the X200 video switcher to view the selected camera for the duration of 
an alarm event (plus post trigger time if selected).  Change the desired camera to be viewed 
during an alarm event using the right and left menu buttons to change the camera number in 
the CAMS column. 

 
TIMER REC – Sets the X200 to timer recording as per the settings in the Timer Recording 
Menu. 

 
• CURRENT STATE – Shows the current OPEN / CLOSED state of each of the 4 alarm 

inputs.  The corresponding number for each alarm input will be highlighted for CLOSED and 
not highlighted for OPEN. 
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Embed Alarm State Menu 
 
 
 
                     EMBED ALARM INPUT STATE 

 
  ALARM IN  EMBED TEXT 
 
   1  YES  LEFT 
 2  YES  RIGHT 
 3  YES  BRAKE 
 4  NO 
 
  POSITION:  TOP 
 
 
            
     
        
 
The Embed Alarm State menu allows embedded text to be shown as part of recorded images 
whilst the corresponding alarm input is active. 
 
The alarm inputs active state (closed or open) is set from the Alarm Inputs menu.  When active 
the user defined text is shown in the images at the position designated (top or bottom).  The 
text will be embedded on all camera views simultaneously and will appear on all selected 
cameras during playback in PCLink200. 
 
The 4 alarm inputs are listed in order as shown in the screen shot above, for each of the 4 
inputs the following options are available. 
 
• EMBED – Determines whether the text is embedded in the recorded images when the 

corresponding alarm input is active. 
 
• TEXT – Up to 8 characters can be entered in this field to be embedded in the recorded 

images when the corresponding alarm input is active.  The text is entered using the 
numbered keys on the X201 Reviewer as per the Camera Text menu. 

 
• POSITION - TOP embeds the text across the top edge of the recorded images and 

BOTTOM embeds the text at the bottom of the recorded images above the timestamp and 
GPS information if these options are active. 
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Alarm Output / LEDs Menu 
 
 
 

   ALARM OUTPUT / LEDs 
 
  LED1 OUTPUT :                                 > RECORD 
  LED2 OUTPUT :           OFF 

 
  ALARM OUTPUT :            > OPEN 
   WHEN  . . . 
  FRONT LEDS :   NO 
  CAMERA DISCONNECTED :  NO 
  HARD DISK WRITE PROTECT : NO 
  HARD DISK FULL :   NO 
  ALARM OCCURRED :  NO 
   
            
     
        
 
This menu sets the conditions for the external LED outputs and alarm output. 
 
• LED1 OUTPUT  
• LED2 OUTPUT 
 

OFF / FAIL / SERVICE / RECORD / ON – LED output 1 can be set to be permanently off or 
on or to duplicate the state or the fail, service or record LED’s on the front panel of the 
X200.   

 
• ALARM OUTPUT 
 

FRONT LEDS – Can be set to NO / SERVICE / RECORD to make the alarm output active if 
either the service or record LED’s are lit on the X200 front panel. 

 
CAMERA DISCONNECTED – When set to YES the alarm output is activated when a 
camera is disconnected from the X200 whilst recording on that camera.  The alarm output 
will become inactive 5 seconds after the camera is reconnected. 

 
HARD DISK WRITE PROTECT – If all the disk is write protected then recording will stop.  
To give the user warning the alarm output can be used to signal when the disk is either 25% 
/ 50% / 60% / 70% / 80% / 90% / 100% write protected. 
 
HARD DISK FULL – If all of the disk is full and single pass recording has been enabled 
then recording will stop.  To give the user warning the alarm output can be used to signal 
when the disk is either 25% / 50% / 60% / 70% / 80% / 90% / 100% full. 

 
ALARM OCCURRED – When set to YES the alarm output is activated when an alarm event 
has occurred.  A battery and sounder may be connected to the alarm output terminals so 
that the user is audibly informed of any new alarm event.  The alarm condition is cleared 
when the triggering condition has cleared. 
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Video Switcher Menu 
 
 
 

      VIDEO SWITCHER 
 

  CAMERA   DWELL TIME 
 
   1   TO   4          > 1  SEC    
   5   TO   16  SKIP 
   
 
   
            
     
        
 
 
 
 
The video switcher menu controls the automatic switching of cameras on the switcher output at 
the back of the X200 (X200-16 only) and also on the main video output when the unit is in 
AUTO mode (selected by pressing the AUTO key on the X201 Reviewer).  On the X201 the 
number key LED is illuminated for the camera shown (1-8 number keys for cameras 1-8 with 
the addition of the 9-16 LED lit for cameras 9 – 16) and the live picture is viewable on the 
monitor. 
 
• CAMERAS – Use the up and down menu buttons to move between items in the menu.  

Pressing the right and left menu buttons next to a camera group will increase or decrease 
the number of cameras in that group respectively. 

 
Please note that this applies to the X200-16.  The X200-04 lists each of the 4 cameras 
separately. 

 
• DWELL TIME – The dwell time can be set from 1 – 30 seconds by using the right and left 

menu buttons to scroll through the options.  Dwell time is how long the switcher will stay on 
a camera before moving to the next camera.  If a camera or group of cameras does not 
need to be included in the switcher set this option to SKIP. 
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HARD DISK CARTRIDGE 

The use of Hard Disk Cartridges other than those supplied by Timespace Technology 
will invalidate the warranty of the X200 recorder, and will constitute a breach of the X200 
operating software copyright.
 
The X200 records onto a 2.5" IDE hard disk contained in a cartridge.  This cartridge is 
removable and can be swapped between X200’s. 
 
The cartridge contains custom electronics.  Only T401-series Hard Disk Cartridges can be used 
with the X200. 
 
The cartridge is connected to a PC for accessing and archiving files using the USB Interface 
Kit.  Please refer to the section on the USB Interface Kit for detailed instructions. 
 
WARNING: Hard Disk Cartridges are sensitive to shock, vibration and humidity. 
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X201 REVIEWER 
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Function 
The X201 Reviewer is used to program the menu settings on X200 and to review recordings on 
the installed Hard Disk Cartridge. 
 
Connect Data Link Cable (supplied with X201 Reviewer) from socket marked "Reviewer" on 
X200 to socket marked "Recorder" on X201. This connection provides power, video and audio 
from X200 to X201. 
 
When power (12V ±1.2V) is applied to the X200 and fed to the reviewer via the Data Link Cable 
the red LED on the bottom panel of the reviewer is illuminated. 
 
The X200 display will be shown on the X201 monitor. 
 
Press the buttons on the X201 to control the X200. 
 
WARNING: When X201 is connected to X200 the power supplied to the X200 must be 
12V+/-1.2V. 
 
The X201 has 5 picture adjustment pots situated at the bottom of the left-hand side of the 
reviewer; these should not under most circumstances need adjusting from the factory settings.  
If however an adjustment is necessary then please ensure that an appropriate plastic trimmer 
tool is used in a gentle manner. 
 
These 5 picture adjustment pots are classified as follows. 
 

i)  NTSC Tint (colour balance when using an NTSC feed) 
ii) Colour 
iii) Brightness 
iv) Contrast 
v) Sharpness (image pixel sharpness/smoothness adjustment) 
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Controls 
The keys on the X201 can be grouped into Menu Navigation, Playback & Recording, Camera 
Switcher and Search & Help. 

Menu Navigation 
 
 
 
 
 
 
 
 
 
 
 

MENU 

MENU
EXIT

 
 
Press any of the 4 menu buttons to enter the main menu.  Once in the menu system, their 
function is as follows: 
 

Move arrow cursor to the previous item. 
 

Move arrow cursor to the next item. 
 

If the arrow cursor is currently at a menu selection, 
(e.g.  RESOLUTION: > HIGH),  
pressing the left button will cycle the value backwards,        
(e.g. to  RESOLUTION: > MEDIUM),  
 
If the arrow cursor is currently at a menu selection  
(e.g.  RESOLUTION: > LOW),  
pressing the right button will cycle the value forwards, 
(e.g. to  RESOLUTION: > MEDIUM). 
   
If the arrow cursor is currently at a sub-menu title 
(e.g.  > OTHER OPTIONS). 
pressing the right button will enter this sub-menu. 

 
The MENU EXIT Key on the X201 reviewer will exit the current menu and move back up 1 level 
in the menu system when pressed.  If already at the top level of the menu pressing this key will 
exit the menu system completely and return to the video switcher. 
 
Once in the menu system the numbered keys are used for inputting data into fields which 
require a user entry such as times and dates. 
 
 
       9          0 
 
 
 
 2 3 4 5 6 7 81
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Playback & Recording  
 
 
 
 
 
 
 

 
 

Rewind through recorded footage.  The normal wind interval is 1 minute.  Pressing the 
button again increases the wind interval to 5 minutes.  Repeated presses increase the 
interval to 10 / 20 and finally 60 minutes.  This rapid scan mode enables fast, flicker-
free searching through recorded material.  If the LED above the stop button is lit the 
unit is in jog mode and the rewind button will rewind through recorded footage image 
by image, with intervals of 1 minute.   
 
Reverse-play through recordings. If the LED above the stop button is lit (jog mode), 
the reverse-play button will jog to the previous keyframe. If the oldest keyframe has 
been reached, reverse playback will stop.  Note that reverse play only operates on 
images that have been first played in a forward direction. 
 
Stop playback. If playback is already stopped, pressing this button again lights the LED 
above and the unit is in jog mode, allowing image-by-image playback.  
 
Play recorded footage. Pressing play for a second time switches to fast play enabling 
all the footage to be played through at the fastest rate. If the LED above the stop button 
is lit, the play button will jog to the next image. If the most recent image has been 
reached, playback will stop.  
 
Fast-forward through recorded footage. If the LED above the stop button is lit the unit 
is in jog mode and pressing the fast-forward button will jog forward.  Similarly to rewind, 
repeated presses of the fast forward enable rapid scan in 5 / 10 / 20 / 60 minute 
intervals. 
 
Record start or stop. If not currently recording (red LED off), pressing this button will 
begin recording from the end of the most recent footage, using the settings specified in 
the Normal Recording menu (see page ). If the unit is currently recording (red LED on), 
this button will stop recording.  
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Camera Switcher  
 
 
 
 
 
 
 
 
 
 
 
 
 

16151413 12 11 10 9

9-16 AUTO 

2 3 4 5 6 7 81

 
 
1-8 Switch the view to camera 1 to 8.  When playing back recorded footage, pressing 

buttons 1 to 8 changes playback to that camera.  If the AUTO LED is lit, buttons 1 
to 8 change the live camera being viewed.  This camera is held on the main 
monitor. 

 
9-16 Press this button before pressing the number buttons 1-8 to access cameras 9-16 

on the X200-16. 
 
AUTO Activate the auto switcher mode. In this mode, the monitor will show a live view 

and the cameras are cycled as specified in the "Video Switcher" menu.  Press the 
AUTO button again to deactivate the auto switcher mode. If any of the buttons 
numbered 1-8 (or 9-16) are pressed while in auto switcher mode, the camera 
switching is stopped, and the selected camera view is held on screen. 

 
Control of the auto switcher does not affect any recording in progress. 
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Search & Help  
 
 

 
 
SEARCH 

       9            0 

 9–16 

 
 
 
 
 
 
 
 HELP 
 
 
HELP Applies when using any menu. Pressing this button will produce a help screen. 

Continue pressing any key to cycle through help screens until menu returns. 
 
SEARCH Go to a specific time and date in the recorded footage. Pressing this button will 

enter the PLAYBACK SEARCH screen as seen below. If the footage on a given 
camera cannot be found (it may not have been recorded), a "NO FOOTAGE FOR 
SELECTED CAMERA" message will be displayed.   

 
 
 

     PLAYBACK SEARCH 
 
           TIME :    00 : 00 
 DATE :  00 / 00 / 00 
 
 PLAY FROM SET TIME DATE 
 
 PLAY OLDEST 
 PLAY NEWEST 
 
 
 
 PRESS MENU EXIT TO EXIT MENU 
     
        
 
• TIME – Use the number keys to enter a time in 24hr format. 
 
• DATE – Use the number keys to enter a date in the format DD/MM/YY. 
 
• PLAY FROM SET TIME DATE – Plays the footage beginning from the time and date 

entered. If there is no footage at the time specified a jump is made to the nearest footage to 
the time given. 

    
• PLAY OLDEST – Plays the oldest available footage on the Hard Disk Cartridge. 
 
• PLAY NEWEST – Plays the most recent footage available on the Hard Disk Cartridge. 
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Audio 
The X201 Reviewer can also be used for audio playback through its built in speaker.  It must be 
noted that at present playback via the X201 is in mono via channel 1 only.   
 
The audio signal from the X200 is transferred along with the video signal via the reviewer cable 
to the X201.  No other cabling is required. 
 
The speaker is located on the rear panel of the X201 reviewer and a headphone output jack is 
located on the bottom panel.  Volume can be controlled via a trimmer pot located next to the 
headphone output jack.  Very little force and the correct trimmer tool must be used with the 
volume control to avoid possible damage to the trimmer pot. 
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USING A PC TO CONFIGURE THE X200 

It is possible to use RemoteLink software to configure the X200 with a serial connection from 
the PC to the rear panel of the X200. 
 
RemoteLink software comprises of a virtual X201 Reviewer and is able to emulate the majority 
of its functions.  This is primarily used via the GSM network to contact and configure the X200 
remotely, although the provision for direct serial connection can be used to connect a PC to the 
X200 via this interface. 
 
To connect to the X200 using RemoteLink via the serial connection firstly connect the X200 
serial port (9-way D-Type connector on the rear panel of the X200) to either COM1 or COM2 
serial ports on the PC.  Start RemoteLink software on the PC (included as part of the 
PCLink200 installation V1.2.0 or higher) and go to the Tools menu > Options. 
 
The following dialogue will appear. 
 

 
 
Select either COM1 or COM2 as required and click OK. 
 
To connect to the X200 go to the File menu > Connect using Cable.  This will contact the X200 
and if a successful connection is made the X200 menu screen should appear in the 
RemoteLink window. 
 
The virtual X201 can now be used as per the X201 Reviewer to configure the X200.  Please 
refer to the X201 Reviewer section of this manual for a detailed description of its functions. 
 
When finished go to the File menu > Disconnect and then exit RemoteLink. 
 
Please note that there is no audio functionality in RemoteLink software and that when 
connected the X200 video switcher dwell times will be multiplied by 10 in order to take into 
account the inherent time delay in the serial/GSM connection. 
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USB INTERFACE KIT 

Transferring Files to PC 
The USB Interface Kit provides all hardware and software necessary to review and archive 
recordings on a PC from a Hard Disk Cartridge when it has been removed from the X200 
Digital Recorder. 
 
No additional device drivers are required for the USB Interface Kit when using Windows 2000 
or XP.  Additional device drivers which can be obtained separately from Timespace Technology 
will need to be installed if using Windows 98 or Millennium.  The USB interface is not 
compatible with Windows 95 or NT. 

Kit Contents 
1x USB / IDE Interface Lead 
1x T401-PSU Mains to 5VDC Power Adaptor 
1x PCLink200 Software CD 
1x X200 Manual CD (Word document) 
 

Connecting to a PC using the USB Interface Kit 
To connect a T401-series Hard Disk Cartridge to a PC via USB you will require a USB Interface 
Kit which is supplied with the necessary lead, external cartridge power supply, PCLink200 
software and Windows drivers. 

 
1) Remove the Hard Disk Cartridge from the X200. 
2) Use the T401-PSU to supply power from a mains outlet to the 5V DC input on 

the rear of the cartridge and slide the power switch on the front of the cartridge 
to the on position. 

3) Wait for approximately 5 seconds until the LED on the front of the cartridge 
settles to a steady green colour. 

4) Plug the multi-pin D shaped IDE USB lead into the rear of the cartridge and 
then plug the smaller USB connector into an available USB port on the PC. 

 
Once the disk has been connected, the PC should take a few seconds to detect the disk and 
will then automatically assign a drive letter to it.  Recording files can now be viewed by 
accessing the new drive letter using Windows Explorer or loaded directly from PCLink200 by 
using the ‘Load XBA file’, ‘Load XBA folder’ or ‘Cartridge Autoload’ options.  It is also possible 
to drag .xba files or folders from a Windows Explorer window and drop them onto the main area 
of the PCLink200 window. 
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Installing USB Interface Kit Drivers (Windows 98 and ME Only) 
USB / IDE Interface Drivers only need to be installed when running Windows 98 and ME.  They 
are not included as standard in the USB Interface Kit and can be obtained from Timespace 
Technology if required.   
 
It is strongly advised that the drivers are not installed when running Windows 2000 and XP as 
they already have appropriate drivers as part of the original Operating System installation.  
Windows 95 and NT are not compatible with the USB Interface Kit. 
 
1 Plug the T401-PSU Mains to 5VDC Power Adaptor into an available mains socket and 

connect the DC output jack to the ‘DC5V’ socket on the rear of the Hard Disk Cartridge.  
Switch the cartridge power switch to the ‘ON’ position.  The Power LED will flash amber 
and then turn green.   

 
2 Connect the IDE end of the USB / IDE Interface Lead to the Hard Disk Cartridge and 

the USB end to an available USB port on the PC. 
 
3 Windows should automatically detect the new hardware.  Select ‘Cancel’. 
 
4 Insert the USB / IDE Driver CDROM version CD50.4.  Use Windows explorer to open 

the directory ‘USBIDE(ISD)’  and then open the directory ‘98&ME’.  Select and run the 
file ‘TPPINST_5_04’.  Follow the onscreen instructions to install the drivers. 

 
5 Select and run the file ‘setup.exe’ from the CDROM and follow the onscreen 

instructions. 
 
PCLink200 software can now be installed from its installation CDROM and used to review and 
archive footage from a Hard Disk Cartridge.  Once PCLink200 has been installed a Hard Disk 
Cartridge can be connected to the PC by following steps 1 and 2 as described above.   
 
Windows automatically detects and assigns the connected cartridge a drive letter and the drive 
can be accessed as per normal in Windows Explorer.  If Windows has a problem locating a 
driver or accessing the drive then please refer to the relevant Windows update site and check 
that all the necessary components for USB compatibility are installed.  Windows XP in 
particular requires at least Service Pack 1 to have been installed and may require further 
updates for USB compatibility. 
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PCLINK200 V1.2.0 REVIEWING AND 
ARCHIVING SOFTWARE 
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Accessing / Storing Images
Introduction 
PCLink200 is a Windows based application included in the USB Interface Kit that allows .xba 
files to be viewed on a PC.  These files are automatically created by the X200 recorder on its 
removable disk cartridge.  The cartridge must be connected to the PC to access the files on the 
cartridge. 
 
Playback options include play, forward-wind, rewind, jog control, jump to markers, time line 
jumping and stop. 
 
Screen shots can be written to the Windows clipboard and pasted into most art packages in the 
BMP (Windows standard) image file format or saved directly to a BMP format disk file. 
 
Sections of video footage can be selected and exported directly to an independent .avi disk file 
 

Minimum Hardware Requirements 
PCLink200 runs on Windows 98SE, Millennium, 2000 & XP. 
 
It is recommended that the minimum hardware requirement is a 2GHz Pentium processor,  
256MByte RAM, USB2 for optimum playback speed. 
 

Installation 
PCLink200 is a utility allowing the user to review and export .xba video footage created using 
the X200 digital video recorder. 
 
To install the software insert the PCLink200 CD ROM into your computers CD ROM drive.  In 
most cases the installation program will run automatically.  If this does not happen use 
Windows explorer to select the CD ROM drive and the installer will start. 
 

Starting 
To start running PCLink200 click Start on the bottom left of the Windows screen and then follow 
Start>Programs>PCLink200 >PCLink200. Note that this location is only valid if the default 
settings were used during installation. 
 

Installing Cartridge 
Remove cartridge with recordings by unlocking slider on front of cartridge and pulling from the 
recorder. 
 
To access recordings on cartridge, take to PC with PCLink200 already installed on PC.  
Connect cartridge to PC using USB Interface Kit and provide power to the cartridge with the 
supplied 5V dc power supply.  Switch the cartridge power switch to the on position. 
 
Windows should after a few seconds list the Hard Disk Cartridge as a new drive and 
automatically assign it with a drive letter. 
 
Please refer to the USB Interface Kit section of this manual for detailed instructions on installing 
and using the USB Interface Kit. 
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Operating 
 
Loading .xba files can be accomplished in a number of ways. 
 
1. If “Cartridge Autoload” has been selected in the Options menu the user will be asked 
 if they want to load all footage from a Hard Disk Cartridge which is attached to the PC 
 before or after PCLink200 is started.  If this option is checked when PCLink200 is 
 running it will look for an attached cartridge and ask the user if they want to load all of 
 the .xba files on the cartridge. 
 
2. “Load XBA file” from the file menu.  This will display a file selection box and allow a 

single .xba file to be selected and loaded. 
 
3. “Load XBA folder” from the file menu.  This will display a file selection box and allow 

the selection of a folder containing multiple .xba files.  If the entire contents of a 
cartridge is to be loaded then the drive letter of the cartridge should be selected.  
Pressing ‘OK’ will then load the entire contents of the folder or cartridge into 
PCLink200. 

 
4. .xba files or folders containing .xba files can be dragged from a Windows Explorer 

window and dropped onto the main area of the PCLink200 window. 
 

User Interface Quick Reference 
 
 

Double Clicking on 
a camera indow 
will select it as full 
screen.  Click again 
to return to multiple 
camera view. 

w

  Camera shortcut 
 

 
 
 
 
 
 
 

 
The current 
playback speed 
can be adjusted by 
selecting from 0.1 
to 10 times normal. 

 
 
 
 
 

The date nd time 
of the currently 
displayed ootage. 

a 

 f

Playback control 
buttons 
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Time and date  
information. 

Camera number.

IPS information.

buttons. 

Footage position nt
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The red border 
indicates the 
currently selected 
camera w dow.  
Hold dow  Shift to 
select multiple 
cameras 
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n

 
 
 
 
 
 

Menu bar
Shortcut icons 
markers.  These 
mark the start 
and end of 
selected 
footage.  They 
can be moved 
by clicking and 
holding down the 
left mouse 
button. 

The timeline shows areas of available footage 
in green.  This can be scaled to show footage 
over appropriate periods of time. 

The playback position marker can 
be moved to a specific date and 
time by clicking and holding the left 
mouse button. 

PC system 
resources 
indicator. 
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File Menu 
 
• Load single or multiple XBA files 
• Close currently open XBA files 
• Print the currently selected 

camera screen 
• Copy current camera screen to 

clipboard as a Windows bitmap 
• Export current camera screen as 

a Windows bitmap 
• Export video between start and 

end markers as either XBA or AVI
• Bring up a list of recently viewed 

XBA files 
• View the properties of the current 

XBA file 
• Exit PCLink200 

 
 
 
 

Se
 

• 

 
• 

 
• 

 
• 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Menu Bar and Shortcut Buttons 
 
 
 
 
 
 
 
 

Load XBA file 

Load XBA folder 

File Properties 

Copy Frame 

Export Frame Export AVI 

Print Frame(s) 

About PC

 
 
 
 
 
 
 
 
 
 
 

Play Controls and Timeline  
C urrent Date and Time 

Start Marker 
Volume Control Playback Speed 

Timeline
Rewind F Forward 

Play 
Jog Back 

Jog Forward 
Stop 

 

Moti
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Use the View Menu to select 
which cameras are to be 
viewed 

Select the camera number 
from the drop down list 

Ticked cameras are displayed 

Camera numbers in grey 
indicate that no footage is 
available for that camera 

Show All Cameras 

Link200 

Show Individual Cameras 
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User Interface in Detail 

Play Controls 
The Play controls are situated in the bottom left hand corner of the PCLink200 window. 
 
 

 
 
 
 
 
 
• Rewind – click once to rewind the footage by a few seconds whilst playing or stopped.  Hold 

down to fast rewind the footage. The size and speed of this rewind is relative to the amount 
you are zoomed in. 

• Stop – Click once to stop the footage at any time. 
• Play – Click once to play footage.  If clicked whilst footage is playing the play button will 

stop the footage. 
• Jog back – Click once to rewind the footage by 1 second (to the nearest available 

keyframe) whilst playing or stopped. 
• Jog forwards – Click once to advance the footage by 2 images whilst stopped. 
• Fast forward – click once to advance the footage by 5 seconds whilst stopped.  Hold down 

to fast forward the footage whilst playing or stopped. 
 
Additionally the space bar on the keyboard may be used to toggle the footage between playing 
and stopped. 

Playback Speed Selector 
Just above the play controls is the Playback speed selector.  This allows the footage to be 
played back from between 0.1 and 10 times its normal playback speed.  Please note that at 
higher playback speeds than 1 times the smoothness of playback will be affected by the size of 
the footage window and the host PC’s processing capability.   
 
In order to optimise the PC’s ability to play back footage at faster than 1x, it is advisable to shut 
down any other programs that are currently running and which may be utilising some of the 
system resources.  If there is no audio present on the recording then it is also advisable to 
disable audio playback (selected in the Audio Menu) so that playback speed is maximised. 

Volume Control 
To the left of the Playback Speed Selector is the volume control.  Slide to the right and left to 
increase and decrease playback volume respectively.  Please note that when audio is disabled 
in the Audio Menu the volume control will be hidden. 

Timeline 
To the right of the play controls is the Timeline.  This can be used to select and view the 
footage at a particular point in time.  Click once on this bar and the footage will jump to this 
time, the playback position indicator can also be dragged by holding down the left mouse 
button.  The two yellow triangles at the beginning and end of the timeline are the start and end 
markers.  By default these will appear at the start and end of the available footage when it is 
loaded, but they can be dragged by holding down the left mouse button to other points of the 
footage if desired.  This is useful when using the ‘Export video’ option on the File menu, which 
exports section of footage between these two markers. 
 
Below the timeline and motion graph are a series of buttons used to select the scale of the 
timeline.  This can be selected to cover from 15 minutes to 1 year; the ‘Fit’ option scales the 
timeline to cover all of the currently loaded footage from beginning to end. 
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Motion Graph 
The motion graph bar is shown below the timeline bar in the PCLink200 window.  This bar 
indicates the relative level of motion (change) in the recording.  The level of motion is indicated 
by the height and intensity of colour of the bar, higher and darker indicates higher motion and 
lower and lighter indicates lower motion. 
 
The motion graph bar will show the level of motion for the currently highlighted camera.  If a 
number of cameras are highlighted then the graph will display the data for the camera which 
has the highest level of motion and not the average level across all cameras.  If no cameras 
are highlighted then the graph will display the data for the camera which has the highest level 
of motion from all of the recorded cameras. 
 
The motion graph feature will only be active with recordings made on X200 operating software 
V1.2.0 and later. 

Time and Date 
The current time and date of the footage shown on the screen is displayed directly above the 
play controls. 
 

Main menu and Toolbar. 
There are a number of menus available in the main menu bar across the top of the PCLink200 
window.  There are also a number of icons on the Toolbar below the menus. ty 

& 
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File Menu. 
 
Load File – Opens a single .xba file from a user specified location.  Select the file and press 
open. 
 
If an .oba (X100) file is selected then PCLink100 will automatically start in a new window and 
the file can be opened from there. 
 
Load Folder – Opens a group of .xba files from a user specified folder.  Select the file and 
press open.  This can also be used to load all the files from a cartridge connected to the PC.  
To do this select the drive letter in My Computer assigned to the cartridge and press open.  All 
of the available footage from the cartridge will then be loaded. 
 
If a folder containing both .xba (X200) and .oba (X100) files is selected then PCLink200 will ask 
which type of files are to be viewed.  If XBA is selected then PCLink200 will load all of the 
available .xba files.  IF OBA is selected then PCLink100 will automatically start in a new 
window and the .oba files can be opened from there. 
 
If a folder containing only .oba (X100) files is selected then PCLink100 will automatically start in 
a new window and the files can be opened from there. 
 
Close Files – Closes currently opened .xba files.  Use this option before switching Cartridges if 
PCLink200 is not to be closed and restarted. 
 
Print – Prints the currently selected camera view. 
 
Copy Image – Copies the currently selected camera view to the clipboard in Windows Bitmap 
format. 
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Export Image – Exports the currently selected camera view as a Windows Bitmap to a location 
specified by the user. 
 
Export AVI (audio not supported) – Exports the section of footage between the start and end 
markers as either a compressed or uncompressed AVI file.  A dialogue box will appear allowing 
the user to select the codec for compression (or uncompressed) and manually set the footage 
start and end times if desired.  The camera selected for export can also be chosen from this 
dialogue. 
 
Export XBA (audio supported) – Exports the section of footage between the start and end 
markers as an XBA file.  A dialogue box will appear allowing the user to select which cameras, 
audio channels and data (GPS and motion) is included in the exported XBA.   
 
The maximum file size can also be limited in order to fit the resultant parts to certain media 
(CD, Zip disk etc.).  In this case if the total size of the exported footage exceeds the maximum 
file size selected then a number of files will be created all with the same name as entered in the 
‘File Name’ box, but having a suffix to the file name ( -part2, -part3 etc.) so that the correct 
order of the parts can be easily determined from the file name.  For example – If a 50MB 
section of XBA footage is exported and the maximum file size is set to 20MB then three files 
will be created, two 20MB in size and one 10MB.  If the user entered the name ‘Export’ into the 
‘File Name’ box then the resulting files would be Export.xba, Export-part2.xba and Export-
part3.xba. 
 
It is also possible to set the start and end times of the exported XBA using the ‘Start Time’ and 
‘End Time’ options at the bottom of the export dialogue, to do this press the ‘…’ button next to 
the relevant option and manually enter the date and time.  This will override the start and end 
markers on the timeline.   
 
If the PCPlayer box is checked then PCPlayer200 software will be copied along with an autorun 
file at the same time and to the same folder as the exported .xba file.  The .xba file (or files), 
PCPlayer.exe and Autorun.inf files can then be copied to a CD.  When this is inserted into a 
PC, PCPlayer200 will automatically start and load the available .xba files on the CD.  This 
allows playback of .xba files without the need to install PCLink200 software. 
 
For more information on PCPlayer200 please refer to the PCPlayer200 section in this manual. 
 
Recent Files – Displays a drop-down list of recently opened .xba files, click on an item to load 
the file.  Please note that this will not work if the file has been moved since it was last opened. 
 
Properties – Brings up a summary of the current .xba file properties such as start/end times 
and file size. 
 
Exit – Exits the PCLink200 program. 
 
View menu. 
 
Toolbar / Status Bar – These can be checked or unchecked to either view or hide the Toolbar 
and Status Bar in the PCLink200 window. 
 
Cameras – This will display a drop-down list of cameras.  Either check or un-check each 
camera to determine whether it is currently displayed or not displayed in the PCLink200 
window.  Cameras with available footage will have their number displayed in black, all others 
will be displayed in grey and are not accessible.   
 
Additionally double left-clicking on any displayed camera window in a multiple camera view will 
display it full screen.  Left-clicking again will revert back to a multiple camera view.  Multiple 
camera views can be selected by holding down the Shift key whilst left clicking on the desired 
camera windows.  If multiple camera windows are selected then double left clicking whilst 
holding down the Ctrl key will display only the selected cameras, left clicking any part of the 
grey area of the PCLink200 window will revert to all camera windows being displayed. 
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Show Selected Cameras – This will display all of the currently checked cameras in the 
Camera list. 
 
Show All Cameras – This will display all cameras for which there is available footage. 
 
Controls menu. 
 
Play / Stop – This will toggle the footage from playing to stopped and vice-versa.  Also 
controlled directly by the Space Bar on the keyboard. 
 
Jog Forwards – Causes the footage to jog forwards.  Also controlled directly by the L key on 
the keyboard. 
 
Jog Backwards – Causes the footage to jog backwards.  Also controlled directly by the J key 
on the keyboard. 
 
Jump to Start Marker – Causes the footage to jump to the start marker.  Also directly 
controlled by the I key on the keyboard. 
 
Jump to End Marker – Causes the footage to jump to the end marker.  Also directly controlled 
by the O key on the keyboard. 
 
Jump to – Brings up a dialogue box allowing the user to input a time and date to jump to.  If no 
footage is present at the selected time and date then the nearest footage will be selected.  The 
jump to dialogue can also be brought up by left clicking on the time and date display above the 
play controls. 
 
Confine Markers to Displayed Footage – Sets the start and end markers to the beginning 
and end of the currently displayed Timeline.  This is useful if only a portion of the total footage 
Timeline is currently being displayed. Also directly controlled by the M key on the keyboard. 
 
Set Left Marker To Play Position – Sets the left (start) marker to the current play position on 
the Timeline. Also directly controlled by the [ key on the keyboard. 
 
Set Right Marker To Play Position – Sets the right (end) marker to the current play position 
on the Timeline. Also directly controlled by the ] key on the keyboard. 
 
Audio menu. 
 
Audio Enabled – Enables audio playback on both channels. 
Left Channel Only – Enables audio playback on the left channel (channel 1) only. 
Right Channel Only – Enables audio playback on the right channel (channel 2) only. 
Audio Disabled – Disables audio playback (Mute). 
 
Options menu. 
 
Cartridge Autoload – Check this option to auto load all footage from a Hard Disk Cartridge 
which is attached to the PC before or after PCLink200 is started.  If this option is checked when 
PCLink200 is running it will look for an attached cartridge and ask the user if they want to load 
all of the .xba files on the cartridge. 
 
If a Cartridge containing both .xba (X200) and .oba (X100) files is connected then PCLink200 
will ask which type of files are to be viewed.  If XBA is selected then PCLink200 will load all of 
the available XBA files.  IF OBA is selected then PCLink100 will automatically start in a new 
window and the OBA files can be opened from there. 
 
If a Cartridge containing only .oba (X100) files is connected then PCLink100 will automatically 
start in a new window and the files can be opened from there. 
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Passwords – Allows the user to set passwords for operation of PCLink200 or just the export 
function.  The password is blank spaces by default and setting it back to this will remove any 
password protection.  When changing passwords the user will be prompted for the old 
password before a new one can be entered. 
 
Preferences – This brings up a menu allowing the user to specify a number of display and 
export preferences. 
 
Help menu. 
 
Access to the Help Menu and information about PCLink200. 
 
Toolbar 
There are a number of icons on the toolbar which mirror functions from the menu. 
 

 Open XBA file 
 

 Open XBA folder 
 

 Displays properties for all the currently loaded .xba files. It also highlights 
the file currently playing and allows the user to double-click files to jump to 
their start times 

 

 Copy current image to clipboard 
 

 Export current image 
 

 Export video between start and end markers 
 

 Print current image 
 

 About PCLink200 
 
All / Individual Camera Buttons – All shows all of the available camera views, clicking on the 
numbered buttons displays that individual camera view.  Hold down CTRL to select multiple 
camera buttons. 
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PCPLAYER200 V1.2.0 REVIEWING 
SOFTWARE 

Introduction 
PCPlayer200 is a stand-alone Windows based application included with PCLink200 Software 
that allows .xba files to be viewed on another PC which does not have PCLink200 installed.   
 
PCPlayer200 is run directly from a CD containing the PCPlayer200.exe, an Autorun.inf file and 
.xba files. 
 
The PCPlayer200 .exe file and an Autorun.inf file are saved to the same location as .xba files 
exported from PCLink200 software.  When these files are written to a CD, PCPLayer200 will 
automatically start, and load all .xba files on the CD when it is inserted into a PC. 
 
Playback options include play, forward-wind, rewind, jog control, jump to markers, time line 
jumping and stop. 
 
Screen shots can be written to the Windows clipboard and pasted into most art packages in the 
BMP (Windows standard) image file format or saved directly to a BMP format disk file. 
 

Minimum Hardware Requirements 
PCPlayer200 runs on Windows 98SE, Millennium, 2000 & XP. 
 
It is recommended that the minimum hardware requirement is a 2GHz Pentium processor,  
256MByte RAM, USB2 for optimum playback speed. 
 

Starting 
A CD containing the PCPlayer.exe file, Autorun.inf file and .xba files should automatically start 
PCPLayer200 and load all .xba files on the CD when it is inserted into a PC.  If PCPlayer200 
does not start automatically use Windows Explorer to view the contents of the CD and then 
double left-click the PCPlayer.exe file to start PCPlayer200. 
 

Differences from PClink200 
 
Although PCPlayer200 and PCLink200 are very similar in most respects, PCPlayer200 does 
not have the following features which are incorporated into PCLink200. 

• Audio playback  
• Load Meter  
• Motion-data display  
• XBA or AVI export  
• Cartridge auto load  
• Password protection 
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User Interface Quick Reference 

 

Double Clicking on 
a camera window 
will select it as full 
screen.  Click again 
to return to multiple 
came  view. ra

 

 
 
 
 
 
 

The current 
playback speed 
can be adjusted by 
selecting from 0.1 
to 10 times normal. 

 
 
 
 
 
 

The date and time 
of the currently 
displa ed footage. 

 
 

y 

Playback control 
buttons 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Camera number.

ire
The red border 
indicates the 
currently selected 
came  window.  
Hold down Shift to 
select multiple 
came s 

ra

ra

 
 
 
 
 
 

 
Menu bar
Shortcut icons
 

GPS position  
and speed data.

Time and date  
information. 

The timeline shows areas of available footage 
in green.  This can be scaled to show footage 
over appropriate periods of time. 

The playback position marker 
can be moved to a specific 
date and time by clicking and 
holding the left mouse button. 
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User Interface in Detail 

Play Controls 
The Play controls are situated in the bottom left hand corner of the PCPlayer200 window. 
 
 

 
 
 
 
 
 
 
 
• Rewind – click once to rewind the footage by a few seconds whilst playing or stopped.  Hold 

down to fast rewind the footage. The size and speed of this rewind is relative to the current 
scale of the timeline. 

• Stop – Click once to stop the footage at any time. 
• Play – Click once to play footage.  If clicked whilst footage is playing the play button will 

stop the footage. 
• Jog back – Click once to rewind the footage by 1 second (to the nearest available 

keyframe) whilst playing or stopped.  When displaying only 1 camera window this will jog 
back a single image instead of 1 second. 

• Jog forwards – Click once to advance the footage by 1 image whilst stopped. 
• Fast forward – click once to advance the footage whilst stopped.  Hold down to fast forward 

the footage whilst playing or stopped. 
 
Additionally the space bar on the keyboard may be used to toggle the footage between playing 
and stopped. 

Playback Speed Selector 
Just above the play controls is the Playback speed selector.  This allows the footage to be 
played back from between 0.1 and 10 times its normal playback speed.  Please note that at 
higher playback speeds than 1 times the smoothness of playback will be affected by the size of 
the footage window and the host PC’s processing capability.  To play footage back at the PC’s 
maximum rate select the Max option.  
 
In order to optimise the PC’s ability to play back footage at faster than 1x, it is advisable to shut 
down any other programs that are currently running and which may be utilising some of the 
system resources. 

Timeline 
To the right of the play controls is the Timeline.  This can be used to select and view the 
footage at a particular point in time.  Click once on this bar and the footage will jump to this 
time; the playback position indicator can also be dragged by holding down the left mouse 
button.   
 
Below the timeline and motion graph are a series of buttons used to select the scale of the 
timeline.  This can be selected to cover from 15 minutes to 1 year; the ‘Fit’ option scales the 
timeline to cover all of the currently loaded footage from beginning to end. 

Time and Date 
The current time and date of the footage shown on the screen is displayed directly above the 
play controls.  To go to a particular time and date in the footage click the current time and date 
with the left mouse button and enter the required time and date into the dialogue box which 
appears. 
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Main menu and Toolbar. 
There are a number of menus available in the main menu bar across the top of the 
PCPlayer200 window.  There are also a number of icons on the Toolbar below the menus. 
 
 

 
 
 
File Menu. 
 
Load File – Opens a single .xba file from a user specified location.  Select the file and press 
open. 
 
Load Folder – Opens a group of .xba files from a user specified folder.  Select the file and 
press open.  This can also be used to load all the files from a cartridge connected to the PC.  
To do this select the drive letter in My Computer assigned to the cartridge and press open.  All 
of the available footage from the cartridge will then be loaded. 
 
Close Files – Closes the currently open .xba files. 
 
Print – Prints the currently selected camera view. 
 
Copy Image – Copies the currently selected camera view to the clipboard in Windows Bitmap 
format. 
 
Export Image – Exports the currently selected camera view as a Windows Bitmap to a location 
specified by the user. 
 
Recent Files – Brings up a list of recently opened .xba files. 
 
Properties – Brings up a summary of the current .xba file properties such as start/end times 
and file size. 
 
Exit – Exits PCPlayer200 
 
View menu. 
 
Toolbar / Status Bar – These can be checked or unchecked to either view or hide the Toolbar 
and Status Bar in the PCPlayer200 window. 
 
Cameras – This will display a drop-down list of cameras.  Either check or un-check each 
camera to determine whether it is currently displayed or not displayed in the PCPlayer200 
window.  Cameras with available footage will have their number displayed in black, all others 
will be displayed in grey and are not accessible.   
 
Additionally double left clicking on any displayed camera window in a multiple camera view will 
display it full screen.  Left clicking again will revert back to a multiple camera view.  Multiple 
camera views can be selected by holding down the Shift key whilst left clicking on the desired 
camera windows.  If multiple camera windows are selected then double left clicking whilst 
holding down the Ctrl key will display only the selected cameras, left clicking any part of the 
grey area of the PCPlayer200 window will revert to all camera windows being displayed. 
 
Show Selected Cameras – This will display all of the currently checked cameras in the 
Camera list. 
 
Show All Cameras – This will display all cameras for which there is available footage. 
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Controls menu. 
 
Play / Stop – This will toggle the footage from playing to stopped and vice-versa.  Also 
controlled directly by the Space Bar on the keyboard. 
 
Jog Forwards – Causes the footage to jog forwards.  Also controlled directly by the L key on 
the keyboard. 
 
Jog Backwards – Causes the footage to jog backwards.  Also controlled directly by the J key 
on the keyboard. 
 
Jump to – Brings up a dialogue box allowing the user to input a time and date to jump to.  If no 
footage is present at the selected time and date then the nearest footage will be selected.  The 
jump to dialogue can also be brought up by left clicking on the time and date display above the 
play controls. 
 
Options menu. 
 
Preferences – This brings up a menu allowing the user to specify a number of display 
preferences. 
 
Help menu. 
 
Access to information about PCPlayer200 and help text. 
 
Toolbar 
There are a number of icons on the toolbar which mirror functions from the menu. 
 

 Open XBA file 
 

 Open XBA folder 
 

 Displays properties for all the currently loaded .xba files. It also highlights 
the file currently playing and allows the user to double-click files to jump to 
their start times 

 

 Copy current image to clipboard 
 

 Export current image 
 

 Print current image 
 

 About PCPlayer200 and help text 
 
 
All / Individual Camera Buttons – All shows all of the available camera views, clicking on the 
numbered buttons displays that individual camera view.  Hold down CTRL to select multiple 
camera buttons. 
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REMOTE OPERATION 

The X200 includes Ethernet Local Area Network (LAN) technology.  It also incorporates a TFTP 
(trivial file transfer protocol) server which allows the video files to be downloaded using either a 
hard-wired or wireless network connection.  The files can be accessed and downloaded using 
any TFTP client application such as Timespace Technology X-Communicate software. 
 
A GSM Modem can also be connected to the serial port of the X200 in order to provide remote 
access with the ability to check live camera views and configure the X200 menu system.  
RemoteLink software is used in order to dial-up the GSM Modem and provides a virtual X201 
Reviewer and all of its associated functions.  It is also possible to use RemoteLink software 
with a direct serial connection from a PC to the X200.  The direct serial connection is described 
in detail in the ‘Using a PC to Configure the X200’ section of this manual. 
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LAN 
Introduction 
This document is intended to provide an introduction to the networking facilities provided by the 
X200 Digital Video Recorder and to assist with the configuration and interoperation between it 
and other networked computers. 
 
Connection to the X200 built-in 10Mb/s Ethernet network adapter is via a standard RJ45 socket 
and from this a connection can be hardwired or via a wireless bridge device such as the 
Netgear ME101. 
 

Configuration 
Configuration of the X200 networking parameters is done via the menu system accessed using 
a X201 reviewer.  The LAN (local area network) menu option presents the user with fields 
which allow the IP address, the subnet mask and the default gateway values to be set.  It also 
allows the user to interrogate the unit’s unique MAC address. 
The X200 LAN menu page is similar to that shown below: 
 

            |  LAN  |      
                   
 
   IP ADDRESS:  > 10.  0.  0.  1 
 
   SUBNET MASK:  255.255.255.  0 
                        
   GATEWAY:       10.  0.  0.254 
 
    PING TEST ... 
             
 
   MAC:        00:0F:B4:00:0A:48 

Unit MAC Address 
All network devices include a unique media access control (MAC) address used to identify it on 
a network.  The address is a 48-bit number, usually represented as 6 bytes – each byte written 
in hexadecimal notation. 

[On the menu, each hexadecimal byte value is separated by a colon.] 
 
All Timespace Technology devices have a MAC address which begins 00 0F B4 followed by 
another three bytes. 

 
e.g.  00 0F B4 00 0A 48 

 
The X200 LAN menu option allows the user to display its MAC address which may be useful in 
configuring access control with wireless networks. 

IP Address 
For devices communicating on a network, messages must identify the source and destination 
with an address.  The IP (internet protocol) address is a 32-bit number that uniquely identifies a 
device connected to the network and is usually represented in a dotted decimal form. 
  
e.g.  10.0.0.28 

 
[The IP addressing scheme is defined by the Internet Engineering Task Force (IETF) document RFC 791] 
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Subnet Mask 
The subnet mask is used to determine what subnet an IP address belongs to. An IP address 
has two components, the network address and the host address.  Subnetting enables a 
network administrator to further divide the host part of the address into two or more subnets. In 
this case, a part of the host address is reserved to identify the particular subnet.  
The subnet mask is the network address plus the bits reserved for identifying the sub network. 
(By convention, the bits for the network address are all set to 1.)  As a mask, it can be used to 
identify the subnet to which an IP address belongs by performing a bitwise AND operation the 
mask and the IP address. The result is the sub network address.  

Default Gateway 
This is the address of the ‘gateway’ in a network that a computer will use to access another 
network if a gateway is not specified for use.  In a network using subnets, it is the address of 
the router that forwards data traffic to a destination outside of the subnet of the transmitting 
device.  

Ping Test ... 
Selecting this option will bring up the ‘ping test’ menu which is similar to that shown below.  
 

          |  PING TEST  |      
                   
 
   PING ADDRESS:   10.  0.  0.  1 
 
 
   >DO PING TEST  |REPLY RECEIVED| 
 
 
   BYTES SENT:               3988 
   BYTES RECEIVED:           5304 
 
 
 

 
Enter the destination IP address of the unit you want to test communication with on the ping 
address line and then select ‘DO PING TEST ...’.  If the destination receives the ping message 
and replies within 10 seconds then ‘REPLY RECEIVED’ is displayed; otherwise ‘NO REPLY’ is 
displayed. 
 

[See the troubleshooting section for further details about ‘ping’ and instructions 
on how to initiate a communications test from a computer attached to the 

network.] 
 
The ‘BYTES SENT’ and ‘BYTES RECEIVED’ fields update in real-time to show how many 
bytes are being transferred to and from the X200 and can provide further indication of data 
transfer. 
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WLAN 
Wireless Ethernet Bridge 

Connection 
The X200 Digital Video Recorder is connected to a network via a standard RJ45 network 
socket.  For a wireless LAN, a direct connection can be made from this port to a wireless bridge 
device (such as the Netgear ME101) using a cross-over cable (usually supplied with the 
wireless bridge.) 

Configuration 
Because wireless devices from different manufacturers provide different facilities, configuration 
is usually performed using a proprietary utility supplied with the device.  The configuration 
process usually involves connecting the device to a network equipped PC and running the 
utility to set up the security and encryption settings.  It will also be necessary to select the 
correct SSID (service set identifier) which is a 32 character string used to identify one wireless 
network from another.  Refer to the installation guide included with the network bridge for more 
specific details. 

Wireless Router 

Configuration 
Two standards are typically in use for the encryption of data transferred over a wireless network 
– WPA (wireless protected access) and the older legacy system; WEP (wired equivalent 
privacy).  The use of either necessitates the configuration of all wireless devices employed on 
the network. 
 

[Where problems are being experienced establishing connection between wireless network 
devices, it is recommended, where possible, to first establish reliable communication with 

encryption turned off.] 

WEP (Wired Equivalent Privacy) 
The WEP security standard uses a key (64 or 128 bits long) to encrypt and decrypt data sent 
over the wireless connection.  All devices on the same network must be configured with the 
same key. 

WPA (Wireless Protected Access) 
The WPA security standard uses a pass-phrase key to encrypt and decrypt data sent over the 
wireless connection to ensure privacy.  All devices on the same network must be configured 
with the same key and encryption technique (TKIP or AES). 

MAC Address Filtering 
MAC address filtering is a security feature which allows you to specify which computers are 
allowed on your network.  Any computer attempting to access the network that is not specified 
in the filter list will be denied access.  When using this feature, the MAC address of each client 
must be added to the list in the router. 
 

[It may be necessary to add both the MAC address of the X200 and the wireless bridge to which it is connected.] 
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Typical X200 Wireless LAN Configuration   
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Troubleshooting 

Hardwired Connection 
If it is suspected that the wireless connection is causing problems, the X200 standard RJ45 
socket allows connection to the network using a standard UTP network cable. 

 
[Note that if a hardwired cable connection is made directly to a single computer then a cross-over cable may be 

necessary.] 

Ping 
The ‘ping’ utility is a software tool used to see if a network device is operating and also to see if 
connections to it are intact. A small packet of data is sent through the network to a particular IP 
address and the computer that sent the packet then waits (or 'listens') for a return packet. If the 
connections are good and the target is working, a good return packet will be received. 

 
[Ping uses the Internet Control Message Protocol (ICMP) Echo function which is detailed in RFC 792.] 

 
The ‘ping’ utility is provided in versions of the Microsoft® Windows® operating system.  It can be 
run by following the instructions below: 

• Press the ‘Start’ button. 

• From the menu, select ‘Run...’ 

• In the dialogue window type command where it says Open. 

• When the command window opens, at the prompt type ping followed by the IP 
address of the device to be tested.  In the example below the IP address of the unit 
being tested is 10.0.0.3 and the unit is replying.  If no response is received the ping 
application will display ‘Request timed out.’ 
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Operation 

Single Client 
The X200 Digital Video Recorder will allow file download to one client at a time.  During file 
transfer, any attempt by another client to download a file will be rejected or ignored.  A transfer 
can be explicitly aborted with a Timespace extension to the TFTP protocol and implicitly 
aborted if no acknowledgement is received in response to a data packet within 20 seconds. 

TFTP 
TFTP (trivial file transfer protocol) is a simple protocol used to transfer files.  The X200 Digital 
Video Recorder includes a TFTP server which follows the protocol as described in the following 
documents: 
 

• The basic TFTP protocol   RFC 1350 
• TFTP option extension    RFC 2347 (1782 )  
• Block size option    RFC 2348 (1783 )  
• Time-out and transfer size options  RFC 2349 (1784)  

 
Timespace Extensions 
While the X200 implementation of the trivial file transfer protocol follows the standards closely, 
it extends upon it to allow the client to interrogate the files stored locally in the recorder.  These 
extensions are: 
 

• Explicit transfer abort 
• Directory listing request 

 
Explicit Transfer Abort 
Since the X200 Digital Video Recorder only supports transfers to one client at a time, provision 
has been made to abort a transfer should either client or source become unable to continue. 

• The X200 will assume that a data transfer has been aborted if no acknowledgement is 
received in response to a data packet within 20 seconds. 

• The X200 will abort a transfer currently in progress if it receives an ABORT command 
(op code 7).  This will allow the same (or another) client to initiate a new transfer. 

 
Directory Listing Request 
The standard TFTP read request (RRQ) packet takes the following form: 
 

2 bytes string 1 byte string 1 byte 
Op Code (1) Filename 0 Mode 0 

 
The Timespace Technology implementation of TFTP on the X200 responds to read request 
packets where the Filename is either dir or dir,n (where n is an integer used to identify the 
index into the directory listing).  The response to such a request is a packet containing 
information about the requested directory entry in the following form: 
 

iii/nnn→lllllllllllllllllllllllll→sssssssssss→cccccccc→mmmmmmmm→zzzzzzzz 
 

where the fields are separated by tab characters (→) and they represent: 
 

i - the index number of the file in the X200 directory 
n - the total number of files in the X200 directory 
l - the long filename 
s - the short filename 
c - the creation time and date 
m - the modification time and date 
z - the file size in bytes. 
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Data Transfer 

Transfer Rate 
The X200 Digital Video Recorder is equipped with a 10Mb/s network interface controller and 
this could be a limiting factor when using with a wireless LAN connection.  Current wireless 
standards include: 

• IEEE 802.11g – provides networking with speeds up to 54Mb/s 
• IEEE 802.11b – provides networking with speeds up to 11Mb/s 

where these are maximum rates.  In practice, the rate adapts according to the S/N (signal to 
noise ratio) and the signal strength – the further apart the two communicating wireless devices, 
the lower the transfer data rate. 

Transfer Range 
The IEEE 802.11b standard limits the radiated power to 0.5W and in general a range of up to 
100m is considered possible when there are no obstructions.  Besides distance, performance 
can be degraded by radio interference, humidity, air temperature, resource contention (if many 
devices are accessing the wireless network simultaneously) and objects that block the signal. 

Antenna 
Antennas direct Radio Frequency (RF) power into a coverage area. Antennas are available 
which produce differing coverage patterns and to maximize the transmission range, the design 
of the antenna connected to your card is crucial. The majority of supplied antennas are omni-
directional - that is, they radiate energy more or less equally in all directions. The correct 
antenna for a site is chosen by determining the antenna that provides the coverage pattern 
best matched to the site coverage requirements.  If the supplied antenna is replaced with a 
directional antenna then a range of up to 3km or more may be possible although this will be 
limited again by any obstructions. 
The increase in coverage within the RF beam width is called the antenna gain, and is 
measured in dB (decibels). Antenna gain improves the range of the signal for better 
communications (for both transmission and reception). As a general rule of thumb, each 1 dB 
increase in antenna gain can result in a range increase of 2.5% indoors or 5% outdoors. Actual 
results will vary depending on the amount and type of obstructions at the site. 

Channels 
The 802.11 standard defines a number of channels which operate at different frequencies in 
the 2.4GHz spectrum.  However, the spectrum allocation means that many of these channels 
overlap.  Additionally, interference from other devices in the 2.4GHz spectrum, such as wireless 
phones, Bluetooth devices and microwave ovens, can make that part of the airwaves quite 
crowded. 
 

Channel Lower Frequency 
(GHz) 

Central Frequency 
(GHz) 

Upper Frequency 
(GHz) 

1 2.401 2.412 2.423 
2 2.404 2.417 2.428 
3 2.411 2.422 2.433 
4 2.416 2.427 2.438 
5 2.421 2.432 2.443 
6 2.426 2.437 2.448 
7 2.431 2.442 2.453 
8 2.436 2.447 2.458 
9 2.441 2.452 2.463 
10 2.446 2.457 2.468 
11 2.451 2.462 2.473 
12 2.456 2.467 2.478 
13 2.461 2.472 2.483 
14 2.473 2.484 2.495 
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Improving Transfer Range 
The following tips may help in increasing the transfer range or the signal strength and signal to 
noise ratio which can help improve the transfer rate. 

• Put the router or access point close to the centre of the area to cover.  

• Reduce the distance between the wireless devices.  

• Keep wireless devices in line of sight, as much as possible.  

• Place routers and access points high, and as clear of obstructions as practical. Try to 
keep antennas at least a metre away from metal fixtures.  Note that antennas on roofs 
do not necessarily give the best results.  

• Keep routers, access points, and antennas away from large amounts of water such as 
fish tanks and water coolers.  

• Put routers and access points near windows only if you want to communicate between 
buildings.  

• Avoid the weaker signals heading downward from routers and access points.  

• If there is a removable antenna, make sure it is fastened securely.  

• For outdoor mounting of antennas note that the coax RF cable should be kept as short 
as possible to minimize RF loss.  Note that the length of cable that comes with the 
antenna is often optimized. 

• Put antennas as close to vertical as practical.  

• If there are possible interfering devices nearby (such as mobile phones or microwave 
ovens) try changing the equipment to use another channel.  

• If there are more than one wireless routers in range of each other, space the channels 
out as much as possible. E.g., for two routers, choose channels 1 and 11. For three 
routers choose 1, 6, and 11.  

• Use access points in areas without coverage.  

• In highly critical situations professional installers may be able to help by doing a site 
survey and following professional installation processes. 
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Glossary 
 

Bridge A device which forwards traffic between network segments based on data 
link layer information. 

ICMP Internet Control Message Protocol 
IP Internet Protocol 
LAN Local Area Network 
MAC Media Access Control 
Ping A software application used to determine whether two network devices are 

capable of communication. 
RF Radio Frequency 
Router A device in a network that handles message transfer between computers. 
SSID Service Set Identifier 
S/N Signal to Noise Ratio 
TCP Transmission Control Protocol 
TFTP Trivial File Transfer Protocol 
UTP Unshielded Twisted Pair 
WEP Wired Equivalent Privacy 
WPA Wireless Protected Access 
WLAN Wireless Local Area Network 

 

110 

In
te

llig
en

t S
ec

ur
ity

 &
 F

ire



LAN/WLAN File Transfer Software (X-
Communicate V1.4)   
Introduction 
The X200 Digital Video Recorder includes Ethernet local area networking (LAN) technology.  It 
also incorporates a TFTP (trivial file transfer protocol) server which allows the stored video files 
to be downloaded using either a hard-wired, or wireless, network connection.  The files can be 
accessed and downloaded using any TFTP client application. 
 
X-Communicate is a simple TFTP client application which runs under the Windows operating 
system to allow the listing and transfer of files from the X200.  The screenshot below shows 
how the application appears during file download. 
 

 
 

Quick Start 
To download a video file from an X200 follow the steps below: 
 

• Start the X-Communicate application 

• Enter the X200 IP address in the host IP address field. 

• Wait until communication has been established (files displayed). 

• Select the required file (scrolling through the pages if necessary) 

• From the menu, select File and then Download. 

• Select a local name for the transferred file. 

• Wait as the file is transferred. 
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Operation 
The screenshot below shows the main areas of the X-Communicate application. 
 

 

Menu 
The menu allows the user to configure and control the X-Communicate application.  Each of 
the menus and options are detailed below: 
 
File 
 
Download 
This menu selection is enabled when a file has been selected (highlighted) in the File Listing 
Area.  When selected, a dialogue is displayed which prompts the user to select the name of the 
file to be used locally.  By default, the same filename as on the X200 is displayed. 
 
If the file with the same already exists then the user is prompted to confirm that it is their 
intention to overwrite that file.  Note that it is also possible to initiate a file download by double 
clicking the required file in the File Listing Area. 
 
Exit 
Selecting this option closes the X-Communicate application. 
 
Options 
 
Multiple Acks 
File download from the X200 using TFTP is accomplished by the transfer of a number of 
blocks, each of which is acknowledged before the next is sent.  To speed up transfer, the 
protocol permits a number of blocks to be in transit which have not been explicitly 
acknowledged.  This approach can improve transfer rates and so the default is for it to be 
selected. 
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1024byte Blocks 
The X200 implementation of the file transfer protocol supports different size blocks.  If this 
option is selected then blocks of 1024 bytes will be transferred; if it is deselected then the files 
will be transferred in blocks of 512 bytes.  In general, the larger block size will incur less 
overhead if the transfer of data is reliable and so will give better transfer rates; hence, this is the 
default. 
 
View 
 
Small Icons 
Selecting this option displays the files on the X200 as small icons. 
 
Icons 
Selecting this option displays the files on the X200 as large icons. 
 
List 
Selecting this option displays the files on the X200 as a list. 
 
Details 
This view option is the default.  Selecting it displays the files on the X200 with details including: 

• Filename 

• Creation Date and Time 

• Modification Date and Time 

• Size (in bytes) 
 
Refresh 
The X-Communicate application interrogates the number of files on an X200 when it firsts 
connects.  To update the file listing, or to re-establish connection with an X200 which may have 
been temporarily disconnected, select this menu option. 
 
Help 
 
About 
Selecting this option display a dialogue window displaying the application name.  The version 
of the application also appears in the dialogue.  In the example below, the version number is 
1.2. 
 

 

113 

In
te

llig
en

t S
ec

ur
ity

 &
 F

ire



X-Communicate Window 
File Listing Area 
The file listing area displays the files stored on the remote X200 that are available for 
download.  Using the menu View options, the files can be displayed as small icons, large icons, 
in a list or with details including creation and modification time and file size. 
A file must be selected in the file listing area before it can be downloaded.  Double-clicking a 
file will initiate the file transfer process. 
 
Where more files are available than can be displayed in the file listing area, the vertical 
scrollbar to the right can be used to move between pages. 
 
File Indicator 
This field shows the number of files available for download on the remote X200 specified by the 
entered IP address. 
 
Page Indicator 
This field shows the current and total page numbers.  Use the vertical scrollbar to the right of 
the File Listing Area to move between pages. 
 
Host IP Address 
Each device connected to a network must be configured with a unique IP address.  Enter the IP 
address of the X200 you wish to connect to in order to download video files. 
 
Status Line 
Displays any status messages should the X-Communicate application be unable to connect to 
the specified X200 and also the transfer rate and time remaining during file download. 
 
Transfer Progress 
A progress bar and a percentage indicator update as a file is downloaded. 
 
Cancel Button 
During file transfer, the download can be aborted at any point by selecting the cancel button. 

Glossary 
 

IP Internet Protocol 
LAN Local Area Network 
TCP Transmission Control Protocol 
TFTP Trivial File Transfer Protocol 
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GSM (RemoteLink V1.2 Software) 
Introduction 
RemoteLink allows the user to connect via a modem to a remote X200 unit equipped with a 
GSM modem, and control it as if using an X201 Reviewer. All features of the X201 Reviewer 
are supported (excluding audio), but image display is slow due to the speed limitations of the 
GSM network.  Menus can be accessed and modified, live video displayed (please note that 
the X200 video switcher dwell times will be multiplied by 10 in order to take into account the 
inherent time delay in the GSM connection) and recorded footage viewed. 
 
RemoteLink PC software allows the user to have the functionality of the X201 reviewer as if it 
were connected to the X200, except from a remote location. 
 
The user can dial up any number of X200’s in turn from a single remote location allowing 
checks and menu changes to be done when vehicles are in operation and not currently 
accessible to an operator equipped with a reviewer. 
 
The X200 can be contacted whenever it is powered and wherever a GSM signal is available.   
 
Facilities 
 
Connect to X200 remotely from any PC with a dial up modem and an available phone line 
Configure X200 menu system remotely 
Verify correct operation of X200 remotely 
Send SMS text messages from X200 to a mobile phone to confirm X200 operation 
Check live camera views 
 
Practical benefits 
 
Check and change menu settings in real-time without having to physically visit the installation 
and connect a reviewer 
Check camera health and views 
Ensure that recorder is performing as expected and either change menu settings or alert the 
need for maintenance of the installation 
 

Overview 
If the user is familiar with setting up the X200 using an X201 reviewer there is little further to 
learn - you have the same functionality but remotely.  The software allows the PC to dial up an 
X200 unit and once the connection is made the control as the reviewer. 
 
It is important to bear in mind that the data rate is 920 bytes per second (a typical full image is 
50,000 bytes) so playing back images, or displaying a live view takes time. 
 
The hardware of a remote link system consists of an X200 connected to a GSM modem and a 
PC with internal or external telephone modem (PSTN) connected to a telephone socket.  For 
every X200 you need a GSM modem, but you may only require one PC to access a number of 
X200 remote systems. 
 
RemoteLink V1.2 PC software will run on Windows 98, ME, 2000 and XP and is included as 
part of the PCLink200 installation V1.2.0 or later. 
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Hardware Required 
 
GSM modem (Dual-band model suitable for UK and European use) 
SIM card (pre-inserted into GSM modem above) 
Antenna for GSM modem 
Serial cable (see specification below) 
Power supply for GSM Modem 
X200 with V1.3.0 software or later 
 
 
Further items required for PC side 
 
PC with dial-up modem connected to phone line able to make outgoing calls 
RemoteLink V1.2 Software 
 
 

Specification of Cabling 

RJ12 Power Cable 
 
Pins  Connect to   Function on modem 
1  12V    +V 
2  12V    free 
3  GND    PD_IN (reset input active high) 
4  12V    IGT_In (Ignition input active high) 
5  GND    free 
6  GND    GND 

RS232 Serial Cable 
 
Female DType9   Male DType9 
Connected to X200  Connected to GSM modem 
 
Pin    Pin    Function 
1    1     DCD 
2    2    RX 
3    3    TX 
4    4    DTR 
5    5    GND 
6    6    DSR 
7    7    RTS 
8    8    CTS 
9    9    RI 
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Installation 

1 Configure the SIM card 
 
A SIM card needs to be plugged into the GSM modem for it to work.  The SIM card provides 
the GSM modem its identity i.e. its phone number and any account information that may be 
needed.  You may need a mobile phone to configure the SIM card.   
 
RemoteLink requires the user to obtain the analogue data number for the SIM card. 
 
The analogue data number is what Remote Link dials to access the GSM unit.  Remote 
Link cannot use the normal mobile phone number that comes with the SIM, but needs a 
specifically assigned data number obtained from the SIM card provider. 
 
Timespace have only used Vodafone SIMs for which an analogue data number is obtainable 
from Vodafone (correct as of May 2005).  Some SIM card providers may not offer this service 
and it should be determined whether this is possible before purchasing a SIM card. 
 
To obtain the analogue data number for a SIM card, contact the provider directly.  You may 
need to register with them and you will need to provide them with the SIM card telephone 
number. 
 
You cannot use the normal mobile phone number of the SIM for GSM modem use.  You may 
also be given a fax number and a digital data number (ISDN number). Neither can be used for 
the RemoteLink application.   
 
To activate the SIM you will usually need to put it into the mobile phone and make a call to any 
phone number.  Someone should pick up the call.  This initiates the SIM into activity.   
 
If you are dealing with multiple modems it is recommended that you keep a list for each SIM of 
the SIM number (written on the SIM,  24 - digit) and analogue data number and normal phone 
number.  If a modem doesn't answer, the SIM provider may be at fault - to fix it they will need 
this information. 
 
Some SIM cards may expire after 3 months or 6 months if no outward calls have been 
made.  It is essential that either the SIM you are using does not expire or the X200 is set 
to send an SMS message at an appropriate interval.  This is set in the SMS OPTIONS sub 
menu accessed via the REMOTE SETTINGS menu in X200 software V1.3.0 or later. 
 
Sending an SMS message from the X200 in order to keep the SIM card from expiring will 
be a chargeable event.  Please ensure that there is sufficient credit on the SIM to send 
an SMS message at the determined intervals. 
 

117 

In
te

llig
en

t S
ec

ur
ity

 &
 F

ire



2 Insert SIM card into GSM modem 
 
Press in the little button on the side of the SIM tray using a pen.  This pushes the SIM tray out.  
Remove the SIM from the mobile phone and place it into the SIM tray and slide the tray back 
into the GSM modem. 
 

3 Connect modem equipment 
  
Connect the modem equipment as shown in the diagram below: 
 
 
 
 

GSM MODEM 
WITH SIM CARD

INSTALLED 

SERIAL
CABLE

ANTENNA 

GSM MODEM 
POWER SUPPLY 

 
 
 
 
 
 
 
 
 
 

X200  
 
 
The X200 system can now be switched on.  It is ready for dial up. 
 

5 Install RemoteLink V1.2 onto PC 
 
RemoteLink PC software is included in the PCLink200 installation V1.2.0 or later. 
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Running RemoteLink 

The RemoteLink main screen is a facsimile of the X201 Reviewer that it emulates, complete 
with screen, buttons and LEDs.  All reviewer functions can be performed including the access 
and control of menus, live video display and recorded footage playback. 
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Selecting a modem 
Before you can dial up any remote you units, you must first select the modem to use. This must 
be a modem that Windows recognises as one that it can use. It may be an internal or external 
version, but you must have installed the drivers that came with it and it must be visible in the list 
of installed modems. To check this list, open the Start menu and choose Settings>Control 
Panel. From the Control Panel list choose “Modems” or “Phone And Modem Options” 
 

 
 
In RemoteLink, choose Tools>Options… from the main menu. The following dialogue will 
appear: 
 

 
 
Click on the list box to see the available modems, and choose one. The highlighted modem will 
be used from now on. Click on OK to confirm you selection. 
 
If you do try to connect to a remote unit without first selecting a modem in this way, RemoteLink 
will not be able to place the call, and will remind you to select a modem. 
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Entering / managing phone numbers 
RemoteLink maintains a list of phone numbers of your remote units. When you contact a 
remote unit, you choose one of these numbers from a list. This avoids mistyping a number. 
 
To Add numbers to the system, choose Tools>Manage Connections… from the main menu. 
This will open the Manage Connections Dialogue. If you click on the Add New… button, the 
Add Number dialogue will open and you can enter the new number and a description of that 
unit. 
 

 
 
 
 
 

 
 
Any phone number you enter must only contain digits and optionally spaces. The unit 
description should be kept concise and will be used to show the user which unit is being 
accessed. Click OK to confirm the new number or Cancel to abort. 
 
To edit and existing number, select it in the Manage Connections dialogue, and click on the 
Edit. 
You may edit the existing phone number and unit name. The same rules apply as for adding a 
new number. Click OK to confirm the changes, or Cancel to abandon the editing. 
 
To delete a phone number, select it from the list and click on Delete. You will be asked for 
confirmation of this action. 
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Contacting a remote unit 

Once a modem has been selected and there is at least one phone number stored in the 
system, RemoteLink will be able to dial a remote unit. To do this choose File>Connect using 
Modem… from the main menu. This will open the Connection dialogue: 
 

 
 
To select the number to dial, click on the down-arrow on the Phone Number drop-down box. 
This will show you all the numbers available. 
 

 
 
Click on the desired number and the drop-down box will close with that number selected. Click 
on the Connect button to start dialling. 
 
The status bar at the bottom of the RemoteLink window shows that it is attempting to connect 
to the remote unit as shown: 

 
 
Upon successful connection the status changes to Connected, along with the unit name: 
 

 
 
To close the connection choose File>Disconnect from the main menu. The call may take a 
second to close down, at which point the status change to Not Connected. 

122 

In
te

llig
en

t S
ec

ur
ity

 &
 F

ire



Operation 

Once a connection has been successfully made to a remote unit, the keyboard, LEDs and 
screen will be active, as if you are using an X201 Reviewer attached to the unit. Live video and 
stored footage can be viewed on the screen, all menus edited and parameters set.  There is a 
noticeable delay when video is being transferred -  please wait for any video to be uploaded.  
Key presses are registered with the X200 after video upload. 
 
 
Important Note. 
It is recommended that PABX extensions should not generally be used for modem connections 
as common in office environments, as they are known to be incompatible. Some PABX lines 
may be configured for use with PC modems, but if this is not available then always use a 
dedicated external line for modems. 
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SPECIFICATIONS 

X200 DIGITAL RECORDER 
Video Recording 
Max Rate  25ips PAL, 30ips NTSC, shared; selectable by camera 
Resolution   Low, Medium, High, V.High 
TVL     540 
Pixels    720 x 288 PAL; 720 x 240 NTSC 
Format                          MPEG2 - full image update or optional conditional refresh 
Input Signal 4 or 16 inputs; composite video 1V p/p; colour/mono; 

PAL/NTSC auto switching 
Simultaneous Functions  Record, Playback, Live views, Ethernet 
Recording Medium  2.5" IDE PC-compatible hard disk in customised cartridge 
Recording Modes  Normal, timer, alarm, single/multi shot, loop or single pass 
Alarm recordings Post-trigger recording; show alarmed cameras live on video 

switcher 
Timer recording   Weekly timer (7 day programmable) or interval timer, or both 
Embedded Text                        Camera number, date and time plus 12 user characters for 

each camera; GPS* speed and position 
 
Audio recording 
Type    Optional 2 line inputs; 2 line outputs; 
Sampling Rate   16kHz 
Sampling Res.   16 bits 
Max Level   Selectable: 0.12V to 2V RMS (0.35V to 5.6V pk-pk) 
 
Configuration 
Entry Menu system with help screens; accessed [with password] by 

X201 Reviewer 
Password   4 user-definable levels 
Language Options  English 
Date Options   dd/mm/yy; mm/dd/yy 
Summertime Correction  UK; Europe; USA; Off 
 
File System 
File Type   Proprietary ".xba", convertible [with password] to AVI 
File Name Optional file text plus date/time, for example:"Bus0034 2004 

month 08 day 16  12_30_00. .xba" 
File Size   10 min or 1 hour 
File Protection Write-protection via file menu; optional automatic write -

protection of alarm recordings 
 
Playback 
Functions   Rewind, Replay, Stop, Play, Fast Forward, Jog mode 
Image Search   Time/date or by file 
 
Remote Operation*   
Systems   Ethernet [LAN/WLAN*], GSM* 
Functions   File transfer to PC (LAN/WLAN), system configuration (GSM)
     
GPS* 
Embedded Text   Position (coordinates) and speed (kph or mph) 
GPS Data   Files contain GPS position/speed/time for mapping 
Clock Lock   Locks X200 clock to world GPS clock 
 
* Additional hardware required - not supplied by Timespace Technology 
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Connections/Controls
Connector Type   Cable harness (X200-16) Individual connectors (X200-04) 
Video Inputs   16 on 25-way "D" connectors (X200-16) 4 x BNC (X200-04) 
Video Out   1 on 25-way "D" connector (X200-16) 1 x BNC (X200-04) 
Switcher Out   1 on 25-way "D" connector (X200-16) 
Audio In  2 line on 25-way "D" connector (X200-16) 2 line on DIN 5 way 

audio socket (X200-04) 
Audio Out  2 line on 25-way "D" connector (X200-16) 2 line on DIN 5 way 

audio socket (X200-04) 
Alarm Inputs   4 on screw terminals 
Alarm Output   1 on screw terminals 
Power Inputs   2.5mm DC socket for PSU 1 x pair screw terminals, 12V  
Modem and/or GPS  9-way "D" connector [RS232 serial] 
LAN/WLAN   RJ45 
Reviewer [X201]  RJ45 
Record On/Off   Push button [menu disable] 
Indicators LED   Power, Recording, Service, Fail 
LED Out 2 x screw terminals for Recording LED and Service/Fail 

combined LED 
 
General
Security Proprietary files; password protection; fragile watermark every 

image [MD5+DES]; embedded camera text  
Power [DC]  12V DC nominal (8V-13V DC max range); 
External Supply  Input: 100V-240V AC 50-60Hz 
  Output: 12DC Regulated, 2A (continuous) 3A (peak) 
Power Recording  0.60A, 12V (7.2W) 
Power Not Recording 0.48A, 12V (5.8W)  
Peak Current  2.8A peak start-up current @ 12V (X201 connected) 
Power on until Recording < 5 seconds 
Clock    TCXO [+/- 4 min/year]; optional GPS locked clock* 
Case    Mild steel, grey painted 
Dimensions [mm]  210 x 112 x 47 (case) 
Dimensions [mm]  220 x 116 x 52 (overall) 
Weight    965g (without cartridge) 
Environment   Indoor use 
Operating Temp. Range +5C to + 40C, 20% to 80% RHStorage Temp. Range -40C to 

+65C 
Mounting   Free-standing or screw-mounted 
Supplied Accessory  Instruction manual; PSU 
Warranty   36 months               

REMOVABLE HARD DISK CARTRIDGE 
Access                                      X201 Reviewer; LAN/WLAN while in X200; PC using USB 

Interface Kit (see below) 
Hard Disk   2.5" IDE 
Power Requirement  5V 1A (PSU supplied with USB Interface Kit) 
Dimensions [mm max.]  143 x 84 x 23 
Weight    ~ 200g depending on type 
Warranty   30 months 
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X201 REVIEWER 
Functions Program menus, check camera views, review live or recorded 

images 
Operation   22 tactile keys with LED indicators 
Power    Powered by X200 
Power Consumption  0.35A, 12V (4.2W) 
Display    3" LCD monitor, TFT, 960[H]x234[V] pixels 
Format    PAL/NTSC 
Audio    Single channel via built-in speaker 
Connectors X200 interface: 8-way RJ45 [serial data; video; audio; DC 

supply]; headphone jack 
Case    Aluminium, grey painted 
Dimensions [mm]  218 x 148 x 52 
Supplied Accessory  Data link cable (X200 to X201) 
Warranty   36 months (monitor 12 months) 

PCLINK200 REVIEWING/ARCHIVING SOFTWARE 
Availability Supplied in USB Interface Kits; software freely available to law 

enforcement agencies 
Compatibility   Recordings made on X200 cartridges 
Access                                     Cartridge or recordings on CD/DVD, PC hard disk (copied or 

LAN/WLAN uploaded files) 
Operating Systems  Windows 98, ME, 2000, XP 
Hardware Requirements 2GHz Pentium, 256MByte RAM, USB2 for optimum playback 

speed 
Security Optional password on PCLink200 software and on export 

video to AVI function 
Language Options  English  
Playback Controls                     Rewind, jog back, stop, play and fast forward, jump to time, 

rapid shuttle via timeline. 
Playback Speed                        Varispeed x0.1, x0.2, x0.5, x1, x2, x3, x4, x6, x8, x10 real-time 

for rapid playback. 
Functions   Real-time playback with audio  

Review archive files on single or multi screen display Copy 10 
min or 1 hour files from cartridge to PC Copy images into 
Microsoft Word or other package 
Activate and verify watermarks 
Export video to AVI file  

OTHER ACCESSORIES 
USB INTERFACE KIT 
For access to X200 recordings via USB1 or USB2 socket of PC; includes software, cables, 
instructions, PCLink200 reading software. 
 
ANTI-VIBRATION KIT 
Shock and vibration protection in mobile and portable applications. 
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TROUBLESHOOTING 

Text Messages 
The following messages may be displayed on the X200 reviewer under the circumstances 
described: 

 
      MANUAL OVERRIDE ENABLED 
 
 You have chosen to override ALARM 
 recording and turn recording off. 
 
 To disable this manual override, 
 press the record key again, after 
 leaving this screen.  
    
 
 
     PRESS ANY KEY TO CONTINUE      

 
The above is displayed when the unit is configured for alarm recording and the record button is 
pressed which will override the configured mode.  Press any key on the reviewer to clear the 
message. 
 

      MANUAL OVERRIDE ENABLED 
 
 You have chosen to override TIMER 
 recording and turn recording off. 
 
 To disable this manual override, 
 press the record key again, after 
 leaving this screen.  
    
 
 
     PRESS ANY KEY TO CONTINUE      

 
The above is displayed when the unit is configured for timer recording and the record button is 
pressed which will override the configured mode.  Press any key on the reviewer to clear the 
message. 
 
 

     MANUAL OVERRIDE DISABLED 
 
 Manual override is now OFF. 
 
 
 
 
  
    
 
 
     PRESS ANY KEY TO CONTINUE      

 
The above is displayed when manual override has been enabled and then subsequently 
disabled again.  Press any key on the reviewer to clear the message. 
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NO SIGNAL.             
       CAMERA DISCONNECTED? 
 
  
    
 
 

 
The above message is embedded within the recording file when the X200 video recorder 
detects that there is no video signal on an input selected for recording.  Check that the camera 
is working and properly connected to the X200 should this message be seen unexpectedly in 
recordings. 

Fail LED 
Illuminated when the X200 video recorder is unable to make recordings.  Check that the hard 
drive cartridge is properly inserted and locked in. 
 

Service LED 
Not currently used. 
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FAQ’s 

X200 
 
"Does not record on power up" Enter menu system; go to OTHER MENU, 

ADVANCED MENU; set to "RECORD AT 
POWER UP". 

  
"Recording at varying times" Check that the TIMER RECORDING MENU 

settings are correct or Timer Recording is 
disabled.  

 
"The recorded picture is grainy" Improve the light level to the camera, or 

increase the exposure level; use a camera 
which works to a lower lux level. 

 
"X200 has all front panel LED’s Ensure cartridge is pushed home and 
illuminated and fails to operate" switched on.  
 
"Cameras connected but no live views" Press "Auto" on the X201 Reviewer.  
 
"No picture on X201 monitor" Ensure that correct power supply to X200  

(12V +/- 1.2V, 2A (continuous) 3A (peak). 
 
"PC can't see disk but recordings The hard disk boot / partition / FAT sectors  
viewable on X200" may have become corrupted.  Go to OTHER 

MENU, FILE SYTEM, FILE SYSTEM CHECK 
MENU and select PERFORM CHECK AND 
CORRECT NOW.  This checks and rewrites 
the boot, partition and FAT sectors of the hard 
disk and removes any corrupted recording 
files.   

 
Please also check the shock and vibration 
damping of the X200 as shock and 
vibration reduce disk life and can also lead 
to corruptions on the hard disk. 
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USB Interface Kit 
 
“PC fails to start if USB Interface Kit and On some PC’s Windows may not start 
cartridge is attached but switched off  correctly if an X200 cartridge is left attached 
during start up” to the PC via the USB Interface Kit during start 

up.  This may be the case even if the cartridge 
is switched off. 
 

“Hard Disk Cartridge appears to be full If the hard disk cartridge has V1.51 of the 
When trying to save X200 software from X100 operating system installed on it then 
a PC Running Windows 98”    although it may have enough free space 
      available to save the X200 .xos file Windows 
      98 shows the disk as full. 

 
• Connect the cartridge to the PC via the USB 

Interface Kit. 
• Go to My Computer and right click on the 

Cartridges drive letter. 
• Select ‘Properties’. 
• Select ‘Tools’. 
• Select error-checking status ‘check now’. 
• Select type of test as ‘Standard’. 
• Select ‘Start’. 

The scan disk process will detect the 
following errors: - ‘System_b’ and ‘System’ 
with the option to ‘repair the error’ 

• Select ‘OK’ 
The scandisk will then detect that the 
information on the disk can be damaged with 
the option to repair the error. 

• Select ‘OK’ 
Scandisk will then show the results from 
scanning the cartridge. 

• Select ‘Close’ 
 

      The cartridge will now allow the user to  
      transfer X200 software onto the cartridge. 
 
USB Interface Kit compatibility Early versions of Windows XP may have  
with Windows XP  some compatibility problems when used with 

USB2 interfaces such as the USB Interface Kit 
supplied to connect an X200 Hard Disk 
Cartridge to a PC.  This situation has been 
resolved with the issue of service pack 1 for 
Windows XP. 
 
If you are having trouble installing and using 
the USB Interface Kit with Windows XP then 
check to see if service pack 1 has been 
installed (My Computer > View System 
Information > General Tab).  If it is not listed 
under the System heading, then it may not 
have been installed and can be downloaded 
from Microsoft. 
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